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Introduction 

Welcome to the RealFlight Drone Flight Simulator 

ealFlight Drone is without question, the most advanced drone simulation 
available.  RealFlight Drone is so technologically advanced and so realistic, 
you’ll find it hard to believe that it’s only a simulation.  RealFlight Drone is the 
ideal way to learn to fly, practice maneuvers, or just have an incredible amount 

of fun. 

The following section briefly outlines some of the exciting features in RealFlight 
Drone.  Subsequent chapters will describe all RealFlight features in complete detail. We 
strongly suggest that you peruse this manual in its entirety, as it explains every feature 
and option, as well as how to use them.   

Finally, we’d like to express our gratitude to you for purchasing RealFlight Drone.  We 
think you will be enormously pleased with RealFlight Drone.  Have fun flying! 

 

RealFlight Drone Feature Highlights 

USB InterLink Elite Controller- 

The InterLink Elite Controller by Futaba is a revolutionary device that offers you the 
following: 

 A high quality USB controller for RealFlight Drone. 

 A built-in interface for (optionally) using your own R/C transmitter to control 
RealFlight Drone. 

 QuickSelect™ Buttons—take control of RealFlight’s menus and options from 
the InterLink Elite without touching the keyboard or mouse. 

 High-speed response to control inputs. 

 Digitally precise inputs with digital trims for unmatched control precision. 
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 A keyboard-free push button reset of the simulation. 

 Instantly rewind your current flight and start over from any point. 

 

Menu-Driven Interface- 

RealFlight Drone utilizes a drop-down menu-driven interface system.  Created for ease 
of use and maximum flexibility, the menu system provides an interface familiar to even 
a casual computer user. 

Additional Features- 

 RealPhysics™ 3D- One of the most ambitious models of flight in the world, 
RealPhysics 3D is unmatched in its ability to re-create the lifelike characteristics 
of model flying.  RealFlight Drone’s physics engine has been tried and 
approved by world-class pilots.  Furthermore, aircraft in RealFlight Drone 
behave with real-world predictability because they are carefully modeled using 
advanced methods and extensive real-world data.  If it happens at the field or 
in the air, it’s re-created with exacting detail in RealFlight Drone! 

 Challenges- These game-like events provide a fun way to test and develop 
your skills.  Each has multiple levels.  Difficulties increase as you move from 
one level to the next.  Successfully earning a medal in each challenge unlocks 
new content. 

 Ghost Runs- Compete against your best time in the Challenges with ghosted 
images of your flights, pushing you to complete each level faster. 

 Instant Rewind- Test your pattern flying over and over again with the new 
Rewind feature.  Hold the Reset button and watch your flight rewind.  Let go 
of the button at the point you wish to re-start your flight.  Use the data lever 
on the controller to seek forward or backwards through your flight. 

 InterLink Elite QuickSelect™- With RealFlight Drone’s InterLink Elite, 
you’re able to make quick changes such as, selecting a different aircraft or 
airport without touching the keyboard or mouse.  

 Quick Load- Know the name of the aircraft or flying site you wish to use? 
Open the Quick Load gadget to quickly search and load the aircraft. 

 Real Rendering™- Taking advantage of cutting edge 3D graphics 
technology, RealFlight not only flies realistically; it also looks true to life. 

 Night Flying- Just because the sun is down, doesn’t mean that you can’t fly.  
The same is true with RealFlight night flying.  Pick a nighttime airport and 
watch as your aircraft lights up the sky. 

 “Full Coverage” collision detection- Instead of using sensors at only a few 
points along the aircraft, “Full Coverage” blankets the entire aircraft with 
detection points ensuring that every part of an aircraft will not only register a 
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strike but, will react authentically.  Contact can result in damage ranging from 
minor handling problems to spectacular crashes complete with realistic sound 
effects. 

 TruFlo Wind Dynamics™- RealFlight Drone introduces drone pilots to 
R/C’s most realistic wind model.  All the components of TruFlo Wind 
Dynamics work together to create the single most accurate wind field in any 
simulation.  Wind impacts every facet of your flight, just as it would at the local 
field. 

 Flying Sites with over 5,000 square miles to explore- RealFlight’s TrueLife 
Terrain™ goes beyond the limitations of traditional simulator flight.  Created 
and mapped from satellite imagery, RealFlight Drone’s landscape looks as 
“right” and richly varied as the view from your front door.  Digital elevation 
data brings it all into accurate perspective. 

 A living, breathing environment- Everything in RealFlight Drone’s 3D 
world is as realistic as possible; complete with depth and details that transcend 
the traditional “billboard” look of other simulators.  You’ll see leaves and 
branches that dance in a passing breeze and clouds that roll by with the 
prevailing winds. 

 VirtualRevolution™ sound technology- Doppler-correct stereo sounds 
heighten the realistic effect with true sound recordings of 2-stroke, 4-stroke, 
turbine, electric, ducted fan and gasoline engines.  As the aircraft crosses the 
field, the engine sound follows, just like its R/C counterpart.   

 RotoSonics™ technology- Recreating distinctive engine/blade sounds with 
startling accuracy.  The sounds are so lifelike, you’ll swear you are at the field! 

 Viewport- You can open up a picture-in-picture display and treat it as an 
independent “window on the world”. You can individually adjust each of the 
viewport’s vantage points, zoom level, and direction of view. 

 Launcher- RealFlight Drone’s Launcher allows for easy one-click access to 
program upgrades, online registration, and technical support. 

 Extensive Help materials- RealFlight Drone features extensive online tool 
tips and diagrams, a detailed manual and technical support to enhance your 
enjoyment of the program. 

 

How to read this manual 

RealFlight Drone is a menu-driven program, which allows you to make quick changes 
without having to reload the simulator each time.  This manual will break out each 
main menu to its own chapter.  This allows you to quickly find information on features 
and functions by the related menus. 
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Along with this manual, a large RealFlight community is available online to help and 
discuss any topics with each RealFlight fan.  This online support, in the form of a 
forum, can be found at: 

http://www.knifeedge.com/forums/ 
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Before You Begin 

To get the most out of RealFlight Drone, it helps to first understand how 
to get the most out of your computer. 

ealFlight Drone is designed to work on a large variety of computer hardware.  
Similar to a car, if you want to go faster, you need a bigger engine.  The same 
holds true with RealFlight Drone. You’ll be able to enjoy the simulator on 
most modern computers, but having the most up to date hardware for your 

computer will greatly increase your enjoyment. 

 

System Requirements 

You will find the suggested system requirements for the RealFlight Drone R/C Flight 
Simulator listed below.  The minimum recommended system requirements are the bare 
minimum PC configuration for installing RealFlight Drone.  Meeting the minimum 
requirements will allow you to enjoy RealFlight Drone.  However, in order to take 
complete advantage of the many features and functions offered by RealFlight Drone, 
you should have a computer that meets or exceeds the specifications as specified in the 
optimum system requirements. 

Minimum Recommended System- 

- Some graphical features may be disabled 
- Aerodynamic Calculations will still be high-quality 

Windows* Vista™, Windows* 7, Windows* 8 or Windows 10* 
   *Administrator Access Required 

Intel Pentium 1.0GHz or equivalent 
512 MB RAM 
3 GB Hard Drive Space 
DVD Drive 
3D Accelerated Video with:  
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- 32 MB Dedicated Video Memory 
- Full DirectX 9 compliant (Shader Model 2.0 or better) 
- Available USB port 

Optimal System- 

- For best graphical performance 

Dual Core 2.4GHz CPU 
2 GB RAM 
3D Accelerated Video with: 
- 512 MB dedicated video memory 

 

Video and Sound Cards 

In order to achieve optimum performance and the best flying experience in RealFlight, 
there are two important components of your computer that deserve special attention:  
the video and sound cards. 

RealFlight Drone has undergone countless hours of compatibility testing and 
evaluation.  As such, this software will adequately function with a variety of video 
cards—ranging from yesterday’s favorites to tomorrow’s hits. 

While RealFlight works well on a wide variety of hardware configurations, it offers 
many features and functions that are designed to take particular advantage of the latest 
video technology.  If you have an older computer, or a newer computer with a lower-
end video card, you may want to consider purchasing a new video card to take 
advantage of these features and functions.  This moderately priced upgrade can vastly 
enhance your enjoyment of RealFlight.  Aside from increasing your satisfaction with 
RealFlight Drone, a new video card will also work with many other games or 
simulators, improving their performance as well. 

While not as important as the video card, upgrading your sound card may also improve 
your satisfaction with RealFlight.  This is especially true if your computer uses an on-
board sound card (a sound card affixed to the motherboard). 

 

Getting the Most out of RealFlight 

We think you’ll agree that RealFlight offers the finest set of instructions and practice 
tools of any simulator suited for both beginners and experienced pilots.  Great Planes 
and Knife Edge Software are committed to the continual improvement of our 
products.  When using the software, you should keep two things in mind: 
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First, similar to other pursuits, what you get out of RealFlight depends upon what you 
put into it.  Mastering radio control requires a great deal of patience and practice.  If 
you crash an aircraft in the simulation, take it very seriously.  Crashing an actual aircraft 
can cost you a lot of time and money.  Try to identify what you did incorrectly, and use 
the experience to avoid making the same mistake again. 

Secondly, while the simulator is quite realistic and will assist you in learning many of the 
skills necessary to become a proficient pilot, there is no substitute for actual flying time 
at the field.  A simulation can be a wonderful practice tool. However, no simulator, no 
matter how realistic, can completely replace a qualified, experienced, human flight 
instructor.  If you are new to drone flight, you should never attempt to fly a real aircraft 
without the supervision of a qualified instructor; no matter how accomplished you are 
on the simulator. 
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Getting Started 

A brief overview and assistance to start you on your adventure. 

his chapter covers the installation procedure for RealFlight Drone, it describes 
the basics of running the program, and introduces you to some of RealFlight’s 
frequently used features. 

The first section, Installing RealFlight Drone, offers a step-by-step approach to the 
installation procedure for both the program software and the controller. 

Second, Exploring RealFlight Drone, offers a brief tour of the RealFlight Drone program.  
You'll learn how to perform some basic functions, such as selecting the aircraft you 
wish to fly, performing simple edits to the flying field, manipulating viewports, and 
using RealFlight’s Virtual Flight Instruction feature. 

This chapter only touches briefly on some of RealFlight Drone’s features.  We strongly 
suggest that you also read the subsequent chapters, which describe the various features 
in comprehensive detail. 

 

Installing RealFlight Drone 

Regardless of whether you plan to use the InterLink controller by itself, or your own 
R/C radio through the built-in transmitter interface, follow the instructions on 
Program Installation in this section. 

Program Installation- 

RealFlight Drone features a simple, one-step installation process.  There are, however, 
further steps that must be followed prior to running the program for the first time.  
This section will explain how to install the RealFlight Drone software and hardware.  
Upon completion of this section, you should be able to fly the aircraft on your PC. 

The InterLink controller’s built-in transmitter interface also allows you to use your own 
R/C transmitter to control RealFlight Drone should you opt to do so.  To activate the 
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interface adapter, you will first need to follow the instructions in the section below.  
This section explains how to use the transmitter interface option in the InterLink 
controller. 

Update Drivers- 

Before you begin installation, we strongly suggest that you update the drivers 
for both the sound and video cards on your PC.  A driver is a software 
program that your computer uses to control hardware devices.  Each card has 
its own respective driver.  Most problems with installing and using RealFlight, 
as well as many other programs that use Microsoft DirectX, arise from using 
outdated video and/or sound card drivers. 

If you are not sure how to update your drivers, you can find instructions in the 
article Q01-1038, “Locating and installing drivers”, at the following address:  
http://www.gpsoftware.com/kb/q01-1038.htm.  This support article will take 
you through the process step-by-step, and has links to driver download sites 
for most manufacturers. 

Connect the InterLink Elite Controller- 

The InterLink Elite controller uses the USB (Universal Serial Bus) port, so 
there is little to do in the way of setup.   

It is imperative that you plug in your controller into the computer first, 
before installing the RealFlight software! 

1. Firmly plug into an available USB port on the PC.  You do not have to 
shut the PC down to plug the controller in. 
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2. Shortly after plugging in, a dialog box should appear on the screen 
indicating that Windows has located a new device and will then 
automatically install the necessary drivers.   

Please note: It is possible that Windows will need to install the appropriate files 
for the InterLink Elite to function properly.  Please have your Windows disc 
available in case it is required. 

Installing the Software- 

After you have completed installation of the InterLink Elite Controller, you are 
now ready to install RealFlight Drone. 

1. Before installing the software, make sure to close any applications that 
you are running.  This includes virus scanning software and other 
similar background applications. 

2. Insert the RealFlight Drone disc into the appropriate DVD drive. 

3. If Auto-Play is active, setup will begin automatically when the DVD 
drive is closed.  Simply click the Install button when prompted.  If 
Auto-Play is not active, click Start on the task bar.  Next, click Run.  In 
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the dialog box that appears, type ‘d:\setup’ (assuming that ‘d’ is your 
DVD drive) and click OK. 

 

Follow the on-screen instructions to complete the setup procedure.  Upon 
completion of the installation, click OK. 

Installing or Updating DirectX- 

1. RealFlight will ask if you wish to install DirectX 9 on your PC.  It is 
important that your PC utilizes DirectX 9.0c.  Click OK to proceed to 
the DirectX License Agreement. 

2. Click "I accept the license agreement" to install DirectX 9.0c.  
Alternatively, if you do not wish to update DirectX at this time, click 
Cancel. 

3. If you have opted to accept the license agreement, click Next to 
proceed with the installation.  DirectX will install the necessary files to 
update your PC. 

4. When prompted, click Finish.  Your PC will power down and then 
restart once again. 

Starting RealFlight Drone- 

1. Double-click the RealFlight Drone Launcher located on your 
desktop. 

2. Type the software serial number and the InterLink controller 
serial number in the appropriate location.  Please be sure to enter the 
numbers exactly as they appear.  Failure to enter the serial numbers 
correctly will not allow you to proceed to the next step.  Once the 
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serial numbers are entered properly, you will see that the OK button 
will now become active and allow you to continue. 

 

 

3. Click OK.  RealFlight Drone will attempt to activate your software.  
The activation process must proceed in order to run RealFlight Drone.  
If the computer is not currently connected to the internet, this 
activation process will fail to connect to the activation server and the 
following window will appear. 
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If you do not have internet access on the computer which RealFlight 
Drone is installed, follow the on-screen prompts.  Write down the 
serial numbers and activation code that appear and log on to 
www.realflight.com/RFDrone on a different computer to activate 
RealFlight Drone.  Alternatively, you may contact Software Support 
via email or phone. 

4. Once activated, the RealFlight Drone Launcher will appear.  Click 
Run RealFlight.  RealFlight Drone will start with the default aircraft 
and default flying site. 
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Using Your Own R/C Radio 

The RealFlight Drone InterLink Elite controller has two different modes of operation.  
By itself, it serves as a realistic ‘standalone’ controller or joystick.  Alternatively, it has a 
built-in interface that lets you use your own R/C transmitter to control RealFlight 
Drone. 

Follow these instructions if you intend to use your own R/C transmitter to control 
RealFlight Drone.  If you do not want to use your own transmitter, you may skip this 
section. 

Connecting Your Transmitter to the InterLink Elite- 

You can use your R/C transmitter to control RealFlight Drone by connecting it to the 
InterLink Elite controller, ‘buddy box’ style (see diagrams).  RealFlight Drone includes 
several cables used to make the connection to many popular R/C transmitters. 

 

Locate the cable input port on the rear of the InterLink Elite Controller.  Plug one end 
of the included connector cable into this port.  Next, plug the other end of the adapter 
cable into the buddy box port (a.k.a. trainer jack) of your transmitter.  The procedure 
for doing so depends on your transmitter: 
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 If your transmitter’s buddy box port directly accepts the 1/8” stereo plug, insert 
this end directly into the radio.  This works for most JR® and Spektrum® radios. 

 If your transmitter’s buddy box port requires the micro (square) connector, use the 
square adapter cord included with the simulator. 

 

Exploring RealFlight Drone 

Now that you have completed the installation of RealFlight Drone, it’s time to begin 
exploring the program.  The following sections will take you on a quick tour of 
RealFlight Drone’s most popular features, such as selecting an aircraft, choosing 
alternate flying locations, customizing the view to your liking, and using the challenges 
to improve your flying skills.  Along the way, we will show you where to go for help 
and how to obtain additional information. 

Start the Program- 

1. For best performance, close all open applications. 

2. Double-click the RealFlight Drone Launcher located on your desktop. 

3. To start the simulation, click the Run RealFlight button. 

The program will start by displaying a Welcome Screen.  The Welcome Screen allows 
you to choose an aircraft, flying site or challenges. 
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If you’d like, you can disable the Welcome Screen by unchecking the box labeled Show 
this dialog on startup.  You may access the Welcome Screen at any time through the Help 
menu. 

The Main RealFlight Display- 

RealFlight Drone is a menu-driven program.  As seen in the picture below, a menu bar 
appears across the top of the RealFlight screen.  Those menus contain additional sub-
menu items and pull-down lists for the related options of the respective menu.  These 
menus allow access to the command and control functions for the RealFlight Drone 
simulation. 

Navigating the Menus- 

To access the various menu items, simply highlight and click the mouse on the 
menu that you would like to view.  For example, clicking on the Aircraft menu 
activates the sub-menu items for that menu. 
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This manual includes a separate chapter for each menu title.  Later chapters 
describe in detail all of the menu items, sub-menus and options. 

Please note: It is also possible to access many of the features and functions of 
RealFlight Drone using hotkeys.  Pressing the H key on the keyboard activates 
the Keyboard Commands dialog, which summarizes the available hotkeys. 

Aircraft Selection- 

When you start RealFlight Drone for the first time, you will immediately be piloting a 
drone.  No special options or complicated choices are required to start flying. Grab the 
InterLink Elite controller and give it a go. 

To select a different aircraft, click the Aircraft menu title in the main menu bar.  Next, 
click the Select Aircraft… menu item found in the drop-down menu.  This activates 
the Select Aircraft dialog (as shown below), which displays a list of available aircraft. 
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Each aircraft available in RealFlight Drone is listed along the left-hand side.  To select 
an aircraft from the list, click on the desired aircraft.  The selected model will now 
appear in the ReadySelect™ preview box.  Additionally, the aircraft’s description and 
information data will appear in the aircraft information pane, which appears just below 
the ReadySelect preview window. 

When you are satisfied with your selection, click OK to return to the simulator using 
the newly selected aircraft. 

Complete information pertaining to the Select Aircraft… menu item is available in 
Chapter 6 of this manual, The Aircraft Menu. 

Alternatively, you may use the InterLink Elite controller to change aircraft selections.  
Simply press the Menu/Select button located on the front of the InterLink Elite 
controller.  This will bring forth the QuickSelect tabs on the left side of the computer 
screen and the aircraft selection tab, represented as a quadcopter icon, should be the 
highlighted tab.  Press the Menu/Select button once again to bring up the 
QuickSelect Aircraft Selection dialog box.  Move the Data Lever, found on the lower 
right side of the InterLink Elite controller, up or down to view the available aircraft.  
To select an aircraft, simply highlight the name and press the Menu/Select button.  
You will return to the simulation using the newly selected aircraft. Further instructions 
can be found on page 72. 
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If you wish to exit the Aircraft Selection screen without making any changes, simply 
press the Reset button on the InterLink Elite. 

Aircraft Most Recently Used List (MRU)- 

If you have selected any different aircraft previously, you will note that these aircraft 
appear on a list in the Aircraft menu; as shown below.  This list is at the very bottom of 
the menu.  This list is commonly referred to as a Most Recently Used, or MRU list.  It 
is limited to the eight most recently used aircraft.  If you wish to fly one of the aircraft 
from this list, simply click on the name of the aircraft in the MRU list. 

 
 

Airport Selection- 

Changing flying sites uses a process similar to selecting an aircraft.  To select a new 
flying location, click the Environment menu title.  Next, click the Select Airport… 
menu item found in the drop-down menu.  This opens the Select Airport dialog. 
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To select an airport from the list, click on the desired airport.  The selected airport will 
now appear in the preview box.  Additionally, an airport description will appear in the 
information pane, which appears just below the preview window.  When you are 
satisfied with your selection, click OK to return to the simulator using the new airport 
selection. 

Navigating the Airport Selection menu using the QuickSelect feature is almost identical 
to the process mentioned previously for selecting aircraft.  Only this time, you will 
select the Airport Selection menu, which is represented by a runway icon.  With the 
QuickSelect tabs visible on the computer screen, move the Data Lever down one 
time.  This should highlight the runway icon.  Press the Menu/Select button to bring 
forth the available flying sites.  Using the same method, as described previously for 
aircraft, select the new airport and press the Menu/Select button to return to the 
simulation using this new flying site. 

Airport Most Recently Used List (MRU)- 

If you have previously selected an alternative flying location, it will appear on a list in 
the Environment menu.  This list is at the very bottom of the menu and is commonly 
referred to as a Most Recently Used, or MRU list.  It is limited to the eight most 
recently selected locations.  If you wish to fly at one of these locations, simply click on 
the respective location in the MRU list to load it into the simulation. 
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QuickSelect Tabs- 

With the InterLink Elite controller, RealFlight Drone offers a revolutionary method 
for accessing many features and functions quickly and easily without ever touching the 
keyboard or mouse.  There are seven main areas of access available through the 
QuickSelect tabs.  They are: Aircraft Selection, Flying Site Selection, Flight Modes, On-
Screen Radio, Binocular View, Viewport, and Heads Up Display (HUD). 

To access any of the QuickSelect tabs, press the Menu/Select button on the 
InterLink Elite controller.  This will bring forth the available options on the left side of 
the computer screen.  Move the Data Lever up or down to cycle through the 
QuickSelect tabs. The highlighted tab is the item that is active.  To access the active tab, 
press the Menu/Select button. 

You can also access the QuickSelect tabs with the mouse by moving the mouse cursor 
over to the left side of the screen.  The QuickSelect tabs will appear and you may click 
on the desired icon. 
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For additional information on how to use the QuickSelect tabs, please refer to the 
information contained in the section entitled QuickSelect- on page 30. 

Some Common Tasks- 

 The easiest method of resetting your aircraft to its original takeoff position is to 
press the reset button located on the front of the InterLink controller.  
Alternatively, you can reset the aircraft by pressing the space bar on the keyboard, 
or by selecting the Reset Position menu item, which is located in the Aircraft 
menu. 

 To zoom in on an aircraft, press the [+] (plus) key on the number pad of the 
keyboard.  Alternatively, you may use menu commands to zoom in.  To do so, 
click on the View menu and then click on the Zoom In menu item.  Each time 
the [+] (plus) key or the Zoom In menu item are pressed or selected, the view will 
increase incrementally. 

 To zoom out of the current view, press the [–] (minus) key on the number pad of 
the keyboard.  Alternatively, you may use menu commands to zoom out.  To do 
so, click on the View menu and then click on the Zoom Out menu item.  Every 
time you press [-] (minus) key or select and press the Zoom Out menu item, the 
view will decrease incrementally. 
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 To reset the view to the default zoom level, press the Backspace on the keyboard. 

Creating a Viewport- 

RealFlight allows you to create an additional picture-in-picture viewport.  Once you 
create a new viewport, you may resize or reposition it by dragging the mouse.  You can 
also adjust all of the viewport’s properties independently of the main window.  The 
viewport may be utilized for a variety of applications, such as changing the viewing 
perspective of your simulation. 

To create a new viewport, click the Gadgets menu title followed by the Viewport 
menu item.  Alternatively, you may also press the ‘4’ key on the keyboard to create an 
additional viewport. 

 

To change the vantage point within the active viewport, press the ‘C’ key on the 
keyboard.  This toggles through the various camera modes, including chase view and a 
fixed viewpoint, or what you would see if you were standing at the side of the runway. 

Also, some aircraft include onboard cameras for additional viewing perspectives.  The 
View chapter of this manual contains a thorough explanation of the viewport and 
camera options. 



 

 25 

Challenges- 

RealFlight Drone offers challenges to help you test and refine your flying skills.  As you 
improve your skills and score well in the challenges, more levels become available, each 
progressing higher in difficulty. 

 

Do well in these challenges, and you may be rewarded for your efforts with new 
content, including new aircraft to fly.  

 

Keyboard Commands 

Many options throughout RealFlight may be activated quickly by a simple press of a 
key on the keyboard.  Below is a list of functions and their related keys.  You may also 
access this list in the simulator by pressing ‘H’ on the keyboard. 

Virtual Channels –  
Channel 5   Y 
Channel 6   U 
Channel 7   I 
Channel 8   O 



 

 26 

Gadget Commands –  
Flight Modes Gadget  1 
Radio Gadget   2 
Binocular Gadget  3 
Viewport Gadget  4 
Heads-Up Display  9 
 
View Commands –  
Reset Aircraft   Space 
Zoom Reset   Backspace 
Zoom In   + 
Zoom Out   - 
Quick Look at Windsock Up Arrow 
Quick Look at Ground  Down Arrow 
Fixed Camera   F1 
Nose Camera   F2 
Chase Camera   F3 
Onboard Cameras  F4-F10 
Set Viewport Camera  Ctrl + F1-F10 
Change Camera Mode  C 
Follow Camera   Shift + C 
Pivot Camera   E 
Orbit Camera   Ctrl + E 
Select Pit Position  X 
Select Previous Pit Position Shift + X 
Select Default Pit Position Ctrl + X 
Change Zoom Mode  Z 
Change Movement Mode Q 
 
Movement Commands – 
Move Forward   W 
Move Backwards  S 
Move Left   A 
Move Right   D 
Move Slow   Ctrl 
Move Fast   Shift 
Move Very Fast   Shift + Ctrl 

Environment Commands – 
Increase Wind Direction Home 
Decrease Wind Direction End 
Increase Wind Speed  Page Up 
Decrease Wind Speed  Page Down 
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Increase Turbulence  Insert 
Decrease Turbulence  Delete 
Increase Sun Azimuth  Shift + Home 
Decrease Sun Azimuth  Shift + End 
Increase Sun Inclination  Shift + Page Up 
Decrease Sun Inclination Shift + Page Down 

Miscellaneous Commands – 
Take Screenshot  Tab 
Look at My Aircraft  T 
Remember Aircraft Position P 
Clear Position   Ctrl + P 
Quick Load Gadget  Ctrl + F 
Mute/Unmute Audio  M 
View Keyboard Commands H 
 
 

Where to Go From Here 

The examples in this chapter only scratch the surface of RealFlight Drone’s 
unparalleled capabilities.  We encourage you to explore RealFlight Drone using some 
of the methods below. 

 Browse through the menus.  Many of the menus are self-explanatory, providing 
you with a more thorough look at the software.   

 If you’d like to learn more about a particular menu or item, look it up in the table 
of contents. 

 If you would like RealFlight Drone to perform a certain function but cannot locate 
the appropriate command, check the index. 

 Use the Help option in RealFlight’s Help menu. 

 Talk to other RealFlight users at www.knifeedge.com/forums. 
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Controlling RF Drone 

Take command of your Drone with the InterLink Elite. 

he transmitter is a key component in all types of R/C flying, including 
multirotor drones.  This unique method of control is part of what separates 
R/C from every other type of aviation.  Consequently, a realistically simulated 
transmitter is an important key to an authentic simulation experience. 

With this in mind, we at Great Planes are proud to offer our revolutionary USB 
InterLink Elite (U.S. Patent #6,842,804 and #7,010,628) controller, made by Futaba.  
The InterLink Elite controller was designed from the ground up to meet the needs of 
the R/C purist.  We believe that no other simulator control method goes further to 
enrich your simulator experience. 
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Features of the InterLink Elite Controller- 

 USB compatibility and convenience.  The InterLink Elite offers the “plug and 
play” convenience, “hot pluggable” installation and removal, as well as the high-
speed digital performance made possible by Universal Serial Bus (USB) 
technology. 

 High quality “mockup” transmitter.  Use the InterLink Elite controller by itself as a 
pseudo R/C transmitter, with the controls you expect in a standard 8-channel 
radio.  The mockup transmitter features two 2-position switches, one 3-position 
switch, a rotary knob, knurled control sticks with adjustable length and a push-
button reset. 

 Built-in transmitter interface.  If you so choose, you can use your own FM or FM-
compatible R/C transmitter to control RealFlight, using the InterLink Elite 
controller’s built-in interface.  You can even switch back and forth between the 
pseudo controller and your own transmitter!  Interface adapter cords are included 
for most JR, Spektrum and Futaba transmitters. 

 QuickSelect menu controls.  With the InterLink Elite, you’re able to make a variety 
of common adjustments to the simulator (such as selecting a different aircraft or 
airport) without having to touch the keyboard and mouse.   

 Easy setup and use.  Simply plug it in and go! 

 

Start Flying! 

When you start RealFlight for the first time, the software will automatically detect the 
InterLink Elite controller.  When you close the Welcome Screen, simply add throttle 
and start flying right away. 

If you are flying with your own radio through the InterLink Elite, please refer to the 
Select Controller section on page 34. 

QuickSelect- 

The InterLink Elite also offers QuickSelect buttons located at the bottom of the 
controller.  These buttons allow you to make simple changes to the simulator without 
having to put the controller down and reach for the keyboard or mouse.  This makes it 
convenient to change the current aircraft and airport, or display popular on-screen 
gadgets. 

To access the QuickSelect tabs, press the Menu/Select button to display a number of 
tabs along the left side of the simulator.  Use the Up and Down direction on the Data 
Lever, located on the lower right side of the controller, to scroll through these options.  
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Pressing the Menu/Select button again will select the highlighted tab.  Pressing the 
Cancel button on the InterLink Elite will exit out of the tabs and hide them. 

Select Aircraft  

Select Airport 

Flight Modes  

Radio Gadget 

Binocular View   

Viewport 

Heads-Up-Display 

 


 

Look for the icon to the left throughout this manual for suggestions on 
when to use the QuickSelect buttons. 
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The Simulation Menu 

Allows access to a variety of simulation-related features, functions and 
options. 

he Simulation menu gives you access to many simulator related features, such 
as switching controller methods, changing simulator settings, or adjusting the 
graphics. 

Clicking the Simulation menu will open the drop-down menu as illustrated in 
the following screen shot. 
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Select Controller… 

RealFlight Drone includes features to help walk you through setting up your choice of 
controller. 

 

After clicking Select Controller…, a new window appears with all the controllers 
available to you.  For many users, you will only see one controller listed.  If you happen 
to have a real transmitter plugged into the InterLink Elite, for example, your screen 
may look something like the following: 
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The controller that is currently in use for flight will have an orange bar next to it as well 
as “(Active)” next to the name.  A few options are available to you from this window: 

 Profile – RealFlight allows you to save profiles for the different radios you 
might want to fly with.  Choose the profile that best matches your controller 
from this drop down list. 

 Edit – Clicking Edit on the Active controller will open a new screen that gives 
you access to modify and adjust the controller’s channels and other 
parameters.  See below for more information. 

 Calibrate – To insure that your controller is properly calibrated to fly aircraft in 
RealFlight, click Calibrate on the Active controller.  See more information 
about the calibration process below. 

 Refresh – If, at any time, you plugged in a radio and turned it on while this 
screen is visible, click Refresh to update the list to include your new controller 
method. 

To switch the Active controller, simply click on an available controller listed.  You will 
see the orange selection bar switch to the new controller as well as “(Active)” appear 
next to the name. 

There are hundreds of radios that are compatible with RealFlight, but not all of them 
function exactly the same.  Some may have a different channel order, or possibly 
reversed.  To assist you with making, changing and saving these settings, RealFlight 
offers controller Profiles. 
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Edit- 

If you wish to use a radio that is not listed in the Profile drop down list, pick 
something similar, then click Edit.  The following screen will appear: 

 

The four columns visible include: 

 Input Channel – This is the list of channels that RealFlight uses for its 
aircraft.  These cannot be modified. 

 Reverse – Check this box to reverse the direction of a channel 

 Value – The bars that appear in this column show the current value 
for each input channel.  For example, if you move the throttle stick on 
your controller, the associated bar will move. 

 RealFlight Channel – This is the channel on your radio that is assigned 
to the Channel column. 
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Using the information from these columns, you can edit the channel lineup to 
match your radio.  For example, if your radio outputs the throttle on channel 1, 
you will follow these steps to correctly assign it to RealFlight’s throttle: 

1. Find “3 Throttle” from the channel column. 

2. Change the Input channel assigned to throttle to Channel 1. 

3. The Value for throttle to move to the far right at full throttle and to 
the far left at idle.  If this is backwards, click the Reverse box for this 
assignment. 

Repeat for all other channels you wish to reassign. 

Enable Software Radio Dual Rates and Expo- 

Some radios allow you to program the expos and dual rates on your 
transmitter.  If you prefer this method, make sure Enable Software Radio 
Dual Rates and Expo is unchecked.  This will bypass RealFlight's software 
radio in favor of your transmitter's settings. 

On the other hand, if you are flying with the InterLink Elite or with a radio 
that does not offer dual rates and expo functionality, you will want to enable 
this feature.  Then, make sure you assign a channel to “5 Dual Rates” in the 
channel assignments above.  RealFlight will then handle all rates and expos for 
you. 

Save and Save As- 

After making changes to your controller profile, you will want to save all 
modifications.  Note that you cannot make changes to stock profiles that are 
included with RealFlight.  If you made changes to a stock profile, the Save 
button will be disabled.  Click the Save As button to save the profile under a 
different name. 

Calibrate- 

Clicking the Calibrate button on the Active controller allows you to adjust and fine-
tune the controller input for the simulation, so that you will achieve the desired 
responses.  Once clicked, the following screen appears: 
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As directed, place all sticks to their center positions.  Click Next when finished. 

 

It is imperative to move all of the sticks, knobs and switches through their complete 
range of motion several times.  This is the key to a properly calibrated controller.  
When completed, click Finish.  You will now be returned to the Select Controller 
screen with a calibrated controller. 
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Virtual Channels- 

Many aircraft that are included with RealFlight require 5, 6, 7 or even 8 channels to 
completely operate them effectively.  Some radios have fewer channels.  If you are 
flying with a radio that has fewer channels than the currently selected aircraft requires, 
you can use the keyboard. 

 Channel 5 Key:  Y 

Pressing Y will act like a two-position switch.  Press the key to flip the switch 
to its opposite position. 

 Channel 6 Key:  U 

Pressing U will activate the knob to one extreme or the other, while holding 
the key down will slowly rotate the knob. 

Channel 7 Key:  I 

Pressing I will act like a two-position switch.  Press the key to flip the switch to 
its opposite position. 

Channel 8 Key:  O 

Pressing O will act like a three-position switch.  A quick press of the key will 
flip the switch to one extreme or the other, while holding the key down will 
place the switch to its center position. 

It might be help to display the Radio Gadget to view these channels in action and to 
assist you in learning how they function. 

 

Graphics… 

Not all computers are created equal.  You might find that RealFlight will perform 
better if you reduce the graphics quality of the simulator.  Alternatively, if you have a 
high-end computer, you might enjoy the visualizations better by increasing the graphics 
quality. 
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At the bottom of the Graphics Quality Settings dialog, you will notice a slider.  Moving 
this from Low to Highest will alter the screen shot displayed above the slider, depicting 
the current selection.  If you find RealFlight is not performing at its peak, try reducing 
these setting. 

The slider will be set at Custom if you decide to alter individual graphics parameters in 
the Settings dialog.  See Settings on page 41 for more information. 

 

Mute/Unmute Audio 

At times, you may want to fly without any sound.  Choose this menu item to mute the 
audio.  Select it again to activate the sounds. 
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Settings 

The Settings option is an integral part of the RealFlight Drone software.  This menu 
item allows you to adjust a multitude of features and functions within the simulation. 
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To access this menu item, click on the Simulation menu followed by the Settings… 
menu item.  The Settings dialog will appear, showing the available options. 



 

 43 

 

Audio- 

The Audio settings allow you to adjust the volume levels for the aircraft and various 
options in the simulation. For each type of sound that is adjustable, there are two 
parameters that can be changed.  First is the Volume, which is a percentage of the 
Overall Volume.  The second is whether the sound should be enabled or muted. 
Double-click on the Audio name, or click on the [+] (plus) to expand the list and 
show the Audio options. 
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Overall Volume (%)- 

This parameter, found when the Audio setting is selected, controls the volume 
for all sounds in RealFlight. 

Sound Enabled- 

This will mute or unmute all sounds in RealFlight. You can select the 
Mute/Unmute Audio menu item from the Simulation menu, or simply press 
M on the keyboard to toggle this setting on or off. 

Application Sounds- 

The Application Sounds section controls the effects and video player sounds 
in the simulation. 
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 Effects Volume (%) – This setting adjusts the master volume level for 
sounds. 

 Effects Enabled – Choosing No for this option will mute all sounds for 
the simulator. 

 Video Player Volume (%) – This setting adjusts the volume level that the 
RealFlight Guided Tour video plays at. 

Simulation Sounds- 

The Simulation Sounds section controls the various options related to the 
miscellaneous sounds in the simulation.  RealFlight allows you to make 
modifications to the various sounds based upon your preferences. 
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For each type of sound that is adjustable, there are two parameters that can be 
changed.  First is the Volume, which is a percentage of the overall volume.  
The second is whether the sound should be enabled or muted. 

The different sound types are: 

 Airport – the ambient sounds around the airport. 

 Collision – the crashing sounds associated with collisions. 

 Engine – the motor sounds. 

 Walk – the walking sound when moving the camera position. 

 Wind – the sound produced by the wind. 

Camera- 

The camera options are designed to enhance the field of view when utilizing the Keep 
Ground in View zoom mode.  For additional information on this option, please refer 
to the View menu chapter of this manual. 
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Minimum Field of View (deg)- 

This setting determines the absolute minimum field of view when utilizing the 
Keep Ground in View zoom option. 

To adjust the minimum field of view, click the existing value.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

Camera Lag (%)- 

This controls how quickly the camera reacts to the aircraft’s movements.  If 
the lag is set to zero, the camera always looks directly at the aircraft.  At all 
other values, the camera will have a spring-like reaction to the aircraft during 
flight. 

At very high values, the camera hardly ever looks directly at the aircraft, and 
often the aircraft will fly off the screen as the camera tries to catch up.  At 
lower values, the effect is very subtle and yet still softens the camera movement 
enough so that minor changes in the aircraft’s speed/position are more 
noticeable. 

Please note:  these settings apply to the “Fixed View” camera mode only.  
They are not applicable to the cockpit, chase, or onboard views. 
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Invert Mouse- 

Setting this parameter to Yes will invert the vertical, or up/down movement of 
the mouse when you are in walk mode. 

Chase Camera Distance (ft)- 

This parameter allows you to adjust the distance which the Chase Camera will 
follow the aircraft from behind. Adjusting this value may assist you in 
Challenges like Balloon Burst. 

Challenges- 

The Challenges option has one parameter which you can modify. From here, you can 
choose if RealFlight Drone will display your best flights in the Challenges as a ghosted 
image.  This allows you to compete against your best time.  Please note: Ghost Runs 
are enabled only after you successfully complete any 5 challenge levels. 

 

This option is on by default.  

 

Console- 

The Console option has a number of sub-categories that allow you to perform 
modifications to the messages that appear on-screen while running the simulator.  It 
also offers two parameters that affect all the sub-categories. 
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Show At Most- 

This numerical value indicates the maximum number of messages that will 
appear on your screen at any given time.  When the maximum number is 
surpassed, an older message will be removed and the most recent message will 
take its place on-screen. 

Clear on Reset- 

This setting controls whether all of the on-screen messages are cleared when 
the aircraft resets.  This prevents the screen from becoming cluttered with 
messages and information. 

Using either the mouse or the up/down arrow keys on the keyboard, select 
Yes (messages automatically clear) or No (messages remain on-screen after a 
reset) from the pull-down listings.  If using the up/down arrow keys, press 
Enter to finalize your selection. 

Double-clicking on the Console name or clicking on the [+] (plus) will bring 
forth the following options: 

 Instructions 

 Notifications 
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 Warnings 

 Errors 

Each of the System Messages screens is independently adjustable and may be 
tailored to suit your personal preferences.  For information on how to do so, 
please read the following section. 

Instructions- 

This option determines the settings for the system Instructions messages. To 
select the Instructions options, click on the Instructions name.   

 

Font Size- 

This option allows you to adjust the font size for the messages 
pertaining to the instructions.  Please note:  this only affects the 
Instructions.  It does not affect any other system messages. 

To access the Font Size options, click on the value shown in the 
respective column.  The desired values may be input directly from the 
keyboard or modified using the mouse wheel. 
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Foreground Color- 

This option allows the user to adjust the color of the foreground for 
the Instructions messages. 

To access the color palette for the foreground color, click on the 
current value, then click the more options button that appears to the 
right (the gray button with the ellipsis).  This will reveal a screen that 
appears as follows: 

 

To select a color, click the desired color on the palette.  If you wish to 
make a custom color, click the Define Custom Colors button and 
create the color or colors to suit your tastes.  Click OK to finalize the 
selection.  The selected color will be reflected immediately in the value 
column. 

Background Color- 

This setting allows you to adjust the color of the background for the 
Instructions messages. 

To access the options pertaining to the background color, click on the 
current displayed color. 

To access the color palette for the background color, click on the 
current displayed color, then click the more options button that 
appears to the right (the gray button with the ellipsis). To select a 
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color, click the desired color on the palette.  If you wish to make a 
custom color, click the Define Custom Colors button and create the 
color or colors to suit your tastes.  Click OK to finalize the selection.  
The selected color will be reflected immediately in the value column. 

Background Alpha (%)- 

This option adjusts the transparency of the text background for the 
message. 

The desired values may be input directly from the keyboard or 
modified using the mouse wheel.  The higher the value, the more 
transparent the text background will become. 

Message Duration (sec)- 

This option adjusts the length of time that a message remains on-
screen before it disappears. 

You may input desired values directly from the keyboard or modify 
them using the mouse wheel.  The higher the value, the longer the 
message remains on-screen. 

Enabled- 

This option determines whether Instructions messages are displayed or 
not. 

To determine whether this is enabled, click on the respective value 
indicator.  Using either the up/down arrow keys on the keyboard, or 
the mouse, select either Yes (Instructions messages are enabled) or 
No (Instructions messages are disabled) from the pull-down listings. If 
using the up/down arrow keys, press Enter to finalize your selection. 

Notifications- 

This option determines the settings for the system Notifications messages.  
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These options function in the same manner as the options for the Instructions 
messages, except that they only affect Notification messages. 

Warnings- 

This option determines the settings for the system Warning messages. 
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These options function in the same manner as the options for the Instructions 
messages, except that they only affect Warning messages. 

Errors- 

This option allows you to modify the behavior of system error messages. 
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These options function in the same manner as the options for the Instructions 
messages, except that they only affect Error messages. 

Graphics Quality- 

The Graphics Quality options are quite useful in fine-tuning your simulator, to ensure 
that it runs as efficiently and realistically as possible on your PC.  Use the settings in the 
Graphics options to obtain the perfect blend of optimal visuals and performance from 
your PC.  If you are experiencing slow frame rates or other performance issues, it may 
be prudent to turn down some graphics quality options. 
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Please note:  Many of the adjustments will not take place immediately.  In 
many cases, you will need to restart the simulator in order for the selection(s) 
to take effect. 

Clouds- 

This option determines whether your flying sites will include clouds in the 
skyline. 

Click on the respective value indicator.  From the pull-down options select 
either Yes (clouds will be present) or No (clouds will not be present).  

Particles- 

This option determines whether RealFlight will utilize particles for things like 
water and smoke. 

Click on the respective value indicator.  From the pull-down options select 
either Yes (RealFlight Drone will display smoke), or No (RealFlight Drone will 
not display smoke). 

Scenery Objects- 

This option determines whether the simulation displays background objects 
such as buildings, rocks, benches, etc.  If Yes is selected, the background 
objects will be present.  If No, the background objects will not appear in the 
simulation. 
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To change this setting, first click on the respective value indicator.  From the 
pull-down options select either Yes or No. 

Shadows Enabled- 

The Shadows option determines whether the simulation displays shadows. 

To change the Shadows setting, click the value located to the right of the 
Shadows name.  Next, click Yes to display the shadows, or No to hide the 
shadows. 

Soft Shadows Enabled- 

This option determines whether or not RealFlight Drone displays softer, more 
realistic appearing shadows. 

Enabling this option may adversely impact performance.  If you notice a poor 
frame rate while running RealFlight, try turning this option to No. 

Terrain Detail- 

This option determines whether or not RealFlight Drone displays the details 
found in the textures. 

Modify the Terrain Detail setting by clicking on the value located to the right 
of the Terrain Detail name.  Click Yes to display the terrain detail texture or 
No, to eliminate the terrain details. 

Trees- 

The Trees setting determines whether or not RealFlight Drone will display 
trees. 

To change the Trees setting, click the value located to the right of the Trees.  
Select No, if you do not wish to display the trees in your simulation.  If you 
wish to view the trees during flight, select Yes. 

Post-processing: Bloom- 

The Bloom effect will cause lighter colors or lights to bleed into neighboring 
parts, enhancing their perceived brightness. 

Please note:  Enabling the Post-Processing: Bloom effect may adversely impact 
performance.  If you notice a poor frame rate while running RealFlight, try 
turning this option to No. 

Post-processing: Night Flying Glow- 

This option affects whether lights for night flying glow, causing the objects to 
appear brighter. 
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Please note:  Enabling the Post-Processing: Night Flying Glow effect may 
adversely impact performance.  If you notice a poor frame rate while running 
RealFlight, try turning this option to No. 

Post-processing: Depth of Field- 

This option affects the strength of the depth-of-field effect.  A stronger effect 
will cause out of focus objects to appear more blurry – great for screen shots.  
Some pilots will prefer to turn this setting lower for actual flight. 

Foliage Density (%)- 

This setting determines the density and drawing time of the trees and the grass.  
Lowering the percentage will ensure that the scenery is drawn faster.  Again, if 
you are experiencing low frame rates, lowering this value will speed up the 
simulation. 

To adjust the percentage, click on the value located to the right of the Foliage 
Density (%) name.  Enter the desired input directly from your keyboard, or use 
the mouse wheel. 

Normal Maps- 

Normal Maps add increased details to aircraft and objects without a large 
increase in video card processing.  Normal Maps are part of the Real 
Rendering feature in RealFlight. 

Water Quality- 

This setting specifies the quality of the water in the simulation.  To modify the 
quality of the water, click on the value indicated in the column to the right of 
the Water name.  Select the desired level for your simulation from the pull-
down list. 

The Highest setting will render the best water, but it requires additional 
processing power.  If your frame rate is low, we suggest reducing the water 
quality.  

Water Particle Quality- 

This setting controls the different type of graphical particles related to water.  
A Low setting turns off all water particle effects while a High setting will 
show wakes, splashes, and ripple effects. 

Water Shadow Quality- 

Turning this setting On, will show shadows on the surface of the water as well 
as on the surface beneath the water for a more realistic appearance. 

Shadow Quality- 

This setting specifies the quality of the shadows in the simulation.  To modify 
the quality of the shadows, click on the value indicated in the column to the 
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right of the Shadows name.  Select the desired level for your simulation from 
the pull-down list.  The Highest setting will render the best shadows, but it 
requires additional processing power.  If your frame rate is low, we suggest you 
reduce the shadow quality. 

Shadow Map Quality- 

Shadow Map Quality setting controls the size of the shadow texture.  A larger 
size texture will show more detail for a more realistic appearance.  A higher 
setting improves the look of the shadows but requires additional processing 
power.  If your frame rate is low, try reducing the shadow map quality. 

Particle Quality- 

This setting adjusts the quality of the smoke, debris and other small objects 
during the simulation.  If the frame rate drops when the smoke is thick, try 
lowering the quality of the smoke until you achieve an acceptable frame rate. 

To do so, click on the existing particle quality.  Next, from the pull-down 
menu, select the desired quality level. 

Screenshot Quality- 

This setting adjusts the quality of the screenshots.  At a low quality, all 
screenshots are saved as JPG files.  If the quality is set to high, screenshots are 
saved as BMP files. 

To change this setting, click on the existing screenshot quality level.  Next, 
from the pull-down menu, select the desired quality level. 

Texture Quality- 

Use this setting to add the realistic textures to the items and various other 
objects found in the simulation. 

To do so, click on the existing texture quality level.  Next, from the pull-down 
menu, select the desired quality option. 

Please note:  You must restart the simulation for the new setting to take effect.  

Misc. Graphics Quality- 

This setting adjusts the quality level of miscellaneous items in your simulation. 

To alter the Miscellaneous Graphics level, click on the value located to the 
right of the Misc. Graphics name.  Next, select the desired level to utilize for 
the graphics.  

Please note:  You must restart the simulation for the new setting to take effect. 
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Heads-Up Display- 

Heads-Up Display is a useful tool to display a variety of flight data in real time similar 
to a FPV (First Person Video) system.  Depending on the environment, you may wish 
to change the color of the HUD. 

 

To change the color, click on the current value, then click the more options button 
that appears to the right (the gray button with the ellipsis).  This will reveal a screen that 
appears as follows: 
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To select a color, click the desired color on the palette.  If you wish to make a custom 
color, click the Define Custom Colors button and create the color or colors to suit 
your tastes.  Click OK to finalize the selection.  The selected color will be reflected 
immediately in the value column. 

Language- 

If you wish to adjust the text throughout the simulator to a different language, you can 
make that change from this setting.  You must restart RealFlight for the change to take 
effect. 
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To select an alternate language, click the respective value, select the language preference 
from the drop-down list that appears. 

Physics- 

The physics options are quite useful in fine-tuning the items applicable to the physics 
of your simulated aircraft. 
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Use Metric Units- 

This option determines the unit of measurement for the various displays found 
in the simulation.  RealFlight defaults to display measurement in SAE units.  
You can easily change this to use metric units. 

To do so, click on the value column to the right of the Use Metric Units name.  
Using either the up/down arrow keys on the keyboard, or the mouse, select 
either Yes or No from the pull-down listings. If using the up/down arrow 
keys, press Enter to finalize your selection. 

Automatic Reset Delay (sec)- 

This setting will force RealFlight to automatically reset the aircraft after a crash 
during which a piece of the aircraft has broken off. 

To adjust the Reset Delay, click the respective value.  Enter the desired value 
directly from the keyboard or use the mouse wheel. 

Pause Sim When in Menu- 

This setting, when enabled, will pause your flight when you access any of the 
menus.  If set to No, your flight will continue even when you access the 
menus.  train 
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Rewind- 

The rewind section allows you to control the parameters for the Rewind feature.  You 
may disable the Rewind feature altogether, or alter how it functions with the followings 
settings. 

 

Enable Rewind- 

The Rewind feature is enabled by default.  If you wish to turn off this feature, 
change this setting to No. 

Enable Audio Effects- 

If you wish to turn off the unique audio effects when activating the Rewind 
feature, change this setting to No.  This setting is set to Yes by default. 

Enable Visual Effects- 

If you wish to turn off the video tape graphical effects when activating the 
Rewind feature, change this setting to No.  This setting is set to Yes by default. 

InterLink Button Reset Threshold (sec)- 

The Rewind feature is only activated if the Reset button is held down for a 
specific amount of time.  This setting allows you to adjust that threshold.  If 
the Reset button is released before this time limit, the flight is simply reset as 
normal. 
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Slowdown Duration (sec)- 

Before the Rewind feature kicks in fully, your flight will slow to a stop, then 
proceed in reverse.  The Slowdown Duration setting allows you to adjust how 
long this process takes. 

Time to Reach Maximum Reverse Speed (sec)- 

This setting allows you to adjust the amount of time it takes before the Rewind 
feature is functioning at full speed. 

Wind- 

The wind and weather options control the atmospheric conditions encountered in the 
simulation.  You can adjust these to match the conditions typically found at your local 
flying site. 

 

Wind Variation (%)- 

This adjustment represents the variation in the wind speed and direction in 
relation to the average speed.  Just as the winds that you experience at the local 
field are not constant, neither are the winds in RealFlight. 

To adjust this variable, click on the value indicated to the right of the Wind 
Variation (%).  Using either your keyboard or the mouse wheel, input a 
numerical value between 0 (unchanging) and 100.  A higher value produces 
more dramatic changes in the wind. 
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Wind Gust (%)- 

This value represents the change of the wind speed and direction 
corresponding to a proportion of the wind speed it calculates in one second. 

To adjust this variable, click on the value indicated to the right of the Wind 
Gust (%).  Using either your keyboard or the mouse wheel, input a numerical 
value between 0 (no changes) and 100 (large changes). 

Turbulence (%)- 

This option allows you to adjust the strength of the turbulence.  Since this 
setting represents a median, some turbulence will be more severe, and some 
turbulence will be less noticeable. 

To adjust the Turbulence Strength Proportion (%) settings, click on the value 
indicated in the column to the right of this option.  The desired values may be 
input directly from the keyboard or modified using the mouse wheel.  A value 
of 0% indicates that there will not be any mid-level turbulence. 

 

Capture Screenshot 

Just like the perfect photo opportunity at the local flying field, RealFlight Drone offers 
the chance to snap off screenshots.  Captured screenshots are great to share with 
friends, add as your desktop wallpaper, or put on the internet for the world to see. 
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To snap a screenshot, click the Capture Screenshot menu item.  Alternatively, press 
the Tab key on the keyboard. 

Screenshots are stored in the My Documents folder.  Each time a screenshot is 
captured, you will receive an on-screen notification as to the storage location. 

 

Show Title Bar 

This menu item determines whether or not the RealFlight Drone title bar is displayed 
on the screen.  By default, the title bar is enabled. 
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To access this menu item, click on the Simulation menu followed by the Show Title 
Bar.  This will remove the RealFlight Drone title bar from the screen. 

Please note:  Removing the title bar also eliminates the ability to minimize or maximize 
the screen. 

 

Exit 

Use this menu item to exit the program entirely. 
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The Aircraft Menu 

Offers access to a variety of aircraft- related features, functions, and 
options. 

licking the Aircraft menu brings forth a pull-down menu similar to the 
following screen shot. 
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Aircraft Selection… 

When you click on Select Aircraft… the following dialog appears: 

 

This dialog allows you to select the aircraft that you wish to fly. 


 

Change aircraft simply by using the InterLink Elite.  Press the 
Menu/Select button, then, with the quadcopter tab highlighted, press 
the Menu/Select button again.  This will bring up the Select Aircraft 
QuickSelect dialog window.  You can continue using the QuickSelect 
buttons in this dialog to select a new aircraft, or press Reset to resume 
flying without making any changes. 

 

Aircraft Selection- 

Every aircraft has its own unique flying characteristics, special features, and functions.  
To view an aircraft from the listings, simply use the mouse to click on the aircraft 
name.  Alternatively, use the up/down keys on the keyboard to scroll through the list 
one aircraft at a time. 
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Have some fun while you’re in the Select Aircraft dialog!  Using the mouse, click and 
drag the preview screen to point the camera angle to your choosing.  Use the scroll 
wheel to zoom in and out or move the gimbals to see the control surfaces move. To 
resume rotating automatically, right-click the preview screen. 

Description/Specifications- 

The pane below the Aircraft Preview box shows either the aircraft description or 
aircraft specifications.  This box provides you with a brief history of the aircraft (if 
applicable) and serves to provide you with specific information pertaining to the model 
selected. 

Using the mouse, select either the Description or Specifications tab. 

 

Remember Aircraft Position 

The Remember Aircraft Position menu item saves the current position of the aircraft.  
When you reset the aircraft, it will return to the same position (speed, attitude, heading, 
etc.). This feature is ideal for practicing maneuvers. 
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To activate this menu item, click the Remember Aircraft Position menu item when 
the aircraft is in the desired location and altitude. 

Each time the aircraft is reset, it will begin flight from the saved location. 

Please note:  The saved position is only temporary.  If you select another airport, 
aircraft, or if you exit the simulation and restart, you will need to save the desired 
position once again. 

 

Clear Aircraft Position 

This menu item clears the position saved in the Remember Aircraft Position without 
exiting the simulation, changing flying sites, and/or aircraft. 

 

To do so, simply click the Clear Aircraft Position menu item.  When the aircraft is 
reset, it will return to one of the default starting positions. 
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  Reset Position 

   There are three ways to reset the aircraft to its takeoff position: 

1. Press the Reset button on the InterLink Elite controller.  This is probably the 
fastest and simplest method. 

2. Press the keyboard’s space bar. 

3. Click the Reset Position menu item. 

 

 

Aircraft MRU 

The final items in the Aircraft menu indicate the most recently used aircraft.  The MRU 
shows only the eight most recently selected aircraft. 
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You can load an aircraft by selecting it from this list.  This shortcut allows you to 
switch between your favorite aircraft without using the Select Aircraft dialog. 
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The Environment Menu 

Allows access to a variety of environment-related features, functions and 
options. 

he Environment menu gives you access to many scenery related features, such 
as changing flying sites, or adjusting weather related items. 

Clicking the Environment menu will open the drop-down menu as illustrated 
in the following screen shot. 
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Select Airport… 

When you click on Select Airport… the following dialog appears: 

 

This dialog lets you choose the flying site that you wish to use for your flight.  Each 
location offers its own unique characteristics and challenges. 


 

Change airports simply by using the InterLink Elite.  Press the 
Menu/Select button, then, using the Data Lever, move down one 
tab and press the Menu/Select button again.  This will bring up the 
Select Airport QuickSelect dialog window.   

You can continue using the QuickSelect button in this dialog to 
select a new airport, or press Reset to resume flying without making 
any changes. 

The rotating image on the right side of the screen provides you with a preview of what 
to expect at the desired location.  The airport information pane below the terrain map 
contains a description and pertinent information regarding the highlighted airport. 

Have some fun while you’re in the Select Airport dialog.  Using the mouse, click and 
drag the preview screen to point the camera angle to your choosing.  To resume 
rotating automatically, right-click the preview screen. 
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When you are satisfied with your selection, click OK to return to your flight using the 
new airport selection.  The Cancel button will return you to the simulation at the 
previously selected flying site. 

Movement Modes- 

RealFlight Drone’s Movement Modes allows you to explore the scenery 
without an aircraft. To select a Movement Mode, press the ‘Q’ key on your 
keyboard.  You can press the ‘Q’ key repeatedly to cycle through the available 
modes:  Walk, Fly, or Hover. 

Walk mode simulates the effect of you, the pilot, physically walking across the 
field, complete with sound effects.  The Fly mode allows you to move through 
the air and position the camera anywhere that you desire. 

Once you have entered the desired Movement Mode, use the ‘W’, ‘S’, ‘A’ and 
‘D’ keys on your keyboard to control the movements.  If you wish to increase 
the speed of your movement, press and hold the Shift key at the same time 
you are using the ‘W’, ‘S’, ‘A’ or ‘D’ key. 

The mouse wheel controls the angle or height at which you traverse the 
scenery.  To increase the altitude, roll the wheel away from you.  This is known 
as the Hover Mode. 

You may also control the zoom levels during your travel.  Press the [+] (plus) 
key to Zoom In and the [-] (minus) key to Zoom Out.  The Backspace key 
resets the zoom level to its default value. 

 

Sun- 

RealFlight Drone gives you the ability to adjust the position of the sun in the sky.  By 
changing the Azimuth, you can rotate the sun around. Change the Inclination to adjust 
how high in the sky the sun should be, or turn day into night by moving the sun below 
the horizon. 
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Adjusting the Sun Azimuth- 

If you customize an airport and find that the sun is always in your flight path, 
adjusting the sun’s azimuth is a good way to move it around the sky, out of your 
way. 

To adjust the azimuth, select the Sun menu.  This will bring forth the Azimuth and 
Inclination options.  Highlight the Azimuth menu item in the pull-down 
selections.  To rotate the sun to the right, click Increase.  Clicking Decrease will 
rotate the sun to the left. 

When altering the azimuth, the simulation temporarily displays the new location in 
the lower left corner of the window. 

Adjusting the Sun Inclination- 

To position the sun higher in the sky, or set it below the horizon, modify the 
inclination. 

To adjust the inclination, select the Sun menu.  This will bring forth the Azimuth 
and Inclination options.  Highlight the Inclination menu item in the pull-down 
selections.  To raise the sun higher in the sky, click Increase.  Click Decrease to 
lower the sun, or to set it below the horizon to make it night time. 
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When altering the inclination, the simulation temporarily displays the new location 
in the lower left corner of the window. 

At night time, RealFlight Drone will automatically enable lighting effects on the 
objects and aircraft that offer the lighting abilities. 

 

Wind- 

RealFlight Drone’s TruFlo Wind Dynamics offers the most realistic wind model of any 
R/C simulator.  Its components work together to capture this complex, ever-changing 
force with unmatched realism.  Just as it would at the field, your model will encounter a 
variety of wind forces as it soars across the skies in RealFlight. 

 

RealFlight offers you the ability to adjust the speed, direction, and turbulence of the 
wind.  To access the Wind settings, click on the Environment menu, followed by the 
Wind menu item.  Several methods may be utilized to adjust the wind speed and 
direction. 
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Adjusting the Wind Direction- 

RealFlight Drone allows you to alter the direction (expressed in degrees) of the 
wind.  This function is perfect for practicing crosswind landings. 

Selecting the Wind menu item brings up the Speed, Direction, and Turbulence 
options.  To adjust the wind direction, highlight the Direction menu item in the 
drop-down selections.  To increase the degree of wind direction, click on the 
Increase option in the drop-down selections.  Likewise, clicking the Decrease 
option lowers the degree of wind direction.  The wind direction degree increases 
and decreases in 15-degree increments. 

When altering the wind direction, the simulation temporarily displays the new wind 
direction, in degrees, in the lower left corner of the window. 

Adjusting the Wind Speed- 

Increasing the wind speed is an ideal way to learn to fly in less-than-perfect wind 
conditions that frequently occur at an R/C field.  To adjust the speed of the wind, 
select the Wind menu.  To adjust the speed of the wind, highlight the Speed menu 
item in the pull-down selections.  To increase the speed of the wind, click on the 
Increase option in the pull-down selections.  Clicking the Decrease option 
reduces the wind speed. 

When altering the wind speed, the simulation temporarily displays the new wind 
speed in the lower left corner of the window. 

Adjusting the Turbulence- 

Increasing the turbulence is another ideal method for learning to fly in challenging 
conditions.  Drone and full-scale pilots alike will all agree that winds are not 
constant.  This setting accurately reflects the lifelike effects of turbulence. 

To adjust the turbulence, select the Wind menu, and highlight the Turbulence 
menu item in the pull-down selections.  To increase the speed of the turbulence, 
click on the Increase option in the pull-down selections.  Clicking the Decrease 
option reduces the turbulence. 

 

Reset to Default 

Selecting Reset to Default will adjust all weather and environment parameters back to 
their default settings for the currently selected flying site. 
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Airport MRU 

 
If you have previously selected an alternative flying location, or locations, you will note 
that it will appear on a list in the Simulation menu.  This list is at the very bottom of the 
menu and is commonly referred to as a Most Recently Used, or MRU list.  It is limited 
to the eight most recently selected locations.  If you wish to fly at one of these 
locations, simply click on the respective location and it will begin loading. 
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Challenges Menu 

Test and improve your flying skills with exciting pilot challenges 

he Challenges menu allows you to practice and improve your flying skills while 
adding some excitement and fun along the way.  There are a variety of 
challenges available with rewards that unlock as you complete more difficult 
levels. 

 

Clicking Select Challenges menu item will display the following screen: 
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Information and a number of options are available to you from this screen.  The most 
obvious is the list of the different types of challenges available.  Displayed with each 
Challenge are any medals that you might have won, along with your progress. 

Ghost Run- 

Once you have completed 5 levels of any Challenges, you are then allowed to 
compete against your best times.  You’ll notice a ghosted image of an aircraft 
flying through levels you have already completed.  This ghosted aircraft 
represents your best time for that level, giving you something to compete 
against. 

 

Quadcopter Trials 

You think you have what it takes to fly a Quadcopter?  Then the Quadcopter Trials 
will test your skills. 
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You’ll be walking and following a quadcopter through a number of obstacles.  Some 
you must fly through, while others are platforms you must land on. 

Scoring is based on how quickly you can fly through each level.  Do well through this 
challenge, and you’ll be rewarded at the end. 

 

Scavenger Hunt 

Flying multi-rotor aircraft from First Person View has become a popular past time.  
Now you can try your hand at doing so, and testing your skills at the same time with 
the Scavenger Hunt Challenge. 
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With each level, you must locate objects around the flying site that are highlighted in a 
red box.  Fly to them closely, and hold that object inside your targeting circle.  Once 
held there long enough, a picture will be snapped by your on-board camera.  At that 
point, you must find the next object. 

Scoring is provided based on how quickly you can find and snap a picture of each 
object.  Try capturing your pictures in different order, finding the best path, to increase 
your time. 

 

During Flight 

While competing in a challenge, a number of options are available to you.  First, in the 
upper left corner is information pertinent to the current challenge.  It will display your 
current time. 

Upper right hand corner of the screen are four buttons: 

 Pause – As the name implies, this will pause your flight.  Click the Resume 
button that is now visible to continue. 



 

 89 

 Restart – Clicking this will return you to the Begin screen where you can view 
your current high score, description of the current challenge, or return to the 
level selection screen. 
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Gadgets Menu 

Determine the method of control, map the channels to your liking, and 
calibrate the controller. 

he Gadget menu offers you a selection of on-screen tools to assist while flying 
your drone. A Gadget is an on-screen display that provides you with 
information pertaining to a certain aspect of your simulation.  To access the 
Gadgets menu item, click the Gadgets menu title.  This will open the list of 

available gadgets for the simulation. 
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Flight Modes 

Many drones offer multiple Flight Modes, depending on the features built-in to the 
flight controller. These can consist of Return-to-Home or Headless-Mode. At times, it 
can be difficult to remember what mode you are in, or what modes are available with 
the currently selected drone. The Flight Modes Gadget can help you with this. 

  

To access the Flight Modes Gadget, click the Gadgets menu title, followed by the 
Flight Modes menu item. 


You may also load the Flight Modes using the InterLink Elite with the 
QuickSelect buttons.  Press the Menu/Select button.  Then press 
down twice on the Data Lever until the Flight Modes tab is 
highlighted.  The Flight Modes tab looks like a transmitter switch. Press 
the Menu/Select button again to activate the Flight Modes Gadget.  
Repeat these steps to remove it from the screen. 

 

 

Radio 

The on-screen radio display is useful for many facets of flight.  For example, when 
used in conjunction with Virtual Flight Instruction, this allows you to see real-time 
control input from the professionals.  Observing the link between controller 
movements and aircraft performance will advance your knowledge and understanding 
of a maneuver. 
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To access the Radio, click the Gadgets menu title, followed by the Radio menu item. 


You may also load the Radio using the InterLink Elite with the 
QuickSelect buttons.  Press the Menu/Select button.  Then press 
down three times on the Data Lever until the Radio tab is highlighted. 
Press the Menu/Select button again to activate the on-screen Radio.  
Repeat these steps to remove the Radio from the screen. 

 

If you click the on-screen radio, the entire viewport is displayed, including the title bar.   

To resize the viewport, position the cursor over the lower right corner of the 
viewport’s frame.  Using the mouse, drag the frame according to your wishes.  If you 
drag it downward, the vertical size of the viewport will increase.  Dragging the frame to 
the right or left increases or decreases the width of the viewport respectively. 

Clicking on the ‘X’ in the title tab of the frame removes it from the screen. 
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Binocular 

The Binocular option will show a perfectly zoomed aircraft, as if you were looking 
through a pair of binoculars.  The background of the viewport box becomes 
transparent.  This provides a visual indicator alerting you that you are using “binocular 
vision.” 

 

The Binocular option is a great way to see the control surfaces on an aircraft that is too 
far away to see in the main view.  Although not realistic, it does help to see the effects 
of control input. 

The Binocular view will automatically hide when the aircraft is close enough to be seen 
in the main window.  The Binocular icon will be visible to indicate that this gadget is 
still active.  The view will reappear when the aircraft flies off into the distance.  If you 
wish for the Binocular view to remain on the screen permanently, simply click the 
thumbtack button in the gadget’s title bar. 

To access the Binocular menu item, click the Gadgets menu title.  Next, click 
Binocular. 


You may also load the Binocular viewport using the InterLink Elite 
with the QuickSelect buttons.  Press the Menu/Select button.  Then 
press down four times on the Data Lever until the Binocular tab is 
highlighted. Press the Menu/Select button again to activate the 
Binocular viewport.  Repeat these steps to remove the Binocular 
viewport from the screen. 
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To resize the viewport, position the cursor over the arrow indication found in the 
lower right corner of the viewport’s frame.  Click and hold on the arrow.  Using the 
mouse, drag the frame according to your wishes.  If you drag it downward, the vertical 
size of the viewport will increase.  Dragging the frame to the right or left increases or 
decreases the width of the viewport accordingly. 

Clicking on the ‘X’ in the title tab of the frame removes the frame from the screen. 

 

Viewport 

The Viewport menu item allows you to open up a smaller window to you can adjust 
independently from the main simulator screen.  This works much like a picture-in-
picture features found on many TVs.   

 

Once you create a new viewport, you can resize or reposition it by dragging with your 
mouse.  You can also fully adjust all the viewport’s properties (zoom level, vantage 
point options, etc.), independent of any properties of the main window. 
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To access the Viewport menu item, click on the Gadgets menu.  Then select 
Viewport.  

 


You may also load the Viewport using the InterLink Elite with the 
QuickSelect buttons.  Press the Menu/Select button.  Then press 
down five times on the Data Lever until the Viewport tab, pictured 
with a computer monitor, is highlighted. Press the Menu/Select 
button again to activate the Viewport.  Repeat these steps to remove 
the Viewport from the screen. 

 

To change the vantage point options and features, use the commands found in the 
View menu.  Ensure that the viewport you wish to modify is the active viewport, or the 
modifications will not take effect.  Alternatively, you may click the left or right arrows 
that appear at the bottom of the Viewport.  This options appears when you move the  

Clicking on the ‘X’ in the viewport’s title bar removes it from the screen. 

 

Heads-Up Display 

The Heads-Up Display (HUD) projects an FPV (First Person Video) or combat jet-
like display over the screen that provides useful data in real time. 


You may load the HUD using the InterLink Elite with the QuickSelect 
buttons.  Press the Menu/Select button.  Then press down on the 
Data Lever until the last tab is highlighted. Press the Menu/Select 
button again to activate the HUD.  Repeat these steps to remove the 
HUD from the screen. 
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Information displayed by location on screen: 

 Upper left – Fuel Remaining 

 Top center – Heading 

 Upper right – Variometer; rate of climb or decent. 

 Left side – Airspeed 

 Center – Pitch ladder, showing the aircraft’s pitch and roll in relationship to the 
horizon. 

 Right side – Altitude 

 Bottom center – Direction and distance to your starting location. 

While the HUD can be displayed at any time, it’s most useful when flying from the 
FPV perspective. 
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Quick Load… 

The Quick Load gadget allows you to rapidly search and select a new aircraft or flying 
site.  Select Quick Load from the Gadgets menu, or press ‘Ctrl + F’ to display the 
following gadget: 

 

To begin your search, begin typing the name of the aircraft or airport you wish to load.  
As you type, any aircraft or airport that is installed that match what you type will begin 
to appear.  The more precise the search word, the narrower the selection of rows 
available.  Select the aircraft or airport you wish to load, and then click OK. 

 

Close All 

This menu item closes all open gadgets.  It offers the user an easy method to clean up 
the screen without having to close each gadget separately. 
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Radio Mode (gadget only)- 

This option allows you to change the Mode in which the on-screen radio is displayed.  
For example, if you prefer to fly with the throttle and rudder on the left stick, and 
ailerons and elevator on the right stick, then you fly Mode 2.  Some pilots prefer Mode 
1.  In this mode, the left stick controls the rudder and elevator; the right stick controls 
the throttle and ailerons. 
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Whichever mode you fly, you will want the on-screen radio to match.  Select Radio 
Mode (gadget only) to show the list of available radio modes.  Click the mode that is 
appropriate for you. 
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View Menu 

Adjust your vantage point, change your location, and more. 

his menu allows you to adjust the various view-related features and functions 
of the simulation.  The View menu adjusts what you are looking at and where 
you are looking from. 
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Scenery 

The Scenery menu item is used to determine whether to show or hide scenery objects 
in the airport. 

 

Selecting this item brings forth a pull-down menu with a list of items you can show 
(make visible within the simulation) or hide (remove from visibility).  To show items, 
check them in the drop-down menu.  To hide items, click on them to remove their 
respective checkmark. 

If the frame rate slows dramatically, try eliminating some of the items listed in the 
Scenery sub-menu.  This will improve the frame rate.  To remove all items from the 
scene, click None. 

 

Camera Type 

The Camera Type menu item determines the Camera Type for the active viewport.  
Each viewport is independently adjustable.  Select from a Fixed Position, Nose or a 
Chase view.  If your aircraft is equipped with on-board cameras, they will be listed 
here as well. 
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To access the Camera Type adjustments, click on the View menu followed by the 
Camera Type menu item.  Select your preferred view from the pull-down list. 

Fixed Position- 

In this mode, the camera remains in a fixed, stationary position.  The position 
is determined by the Camera Position setting. 

Nose- 

The Nose selection places the camera at the front of the aircraft looking 
forward. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key 
on the keyboard.  Each time you press the [+] (plus) key or select the Zoom 
In menu item, the zoom level increases incrementally.  Alternatively, you may 
select the Zoom In option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the 
[-] (minus) key on the keyboard.  Each time you press the [-] (minus) key or 
select the Zoom Out menu item, the zoom level decreases incrementally.  
Alternatively, you may select the Zoom Out option from the View menu. 
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Chase- 

The Chase mode positions the camera behind the aircraft.  The camera will 
follow the aircraft as it moves. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key 
on the keyboard.  Each time you press the [+] (plus) key or select the Zoom 
In menu item, the zoom level increases incrementally.  Alternatively, you may 
select the Zoom In option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the 
[-] (minus) key on the keyboard.  Each time you press the [-] (minus) key or 
select the Zoom Out menu item, the zoom level decreases incrementally.  
Alternatively, you may select the Zoom Out option from the View menu. 

Onboard Cameras- 

Typically these take the form of a fixed or gimbaled camera mounted beneath 
the aircraft.  Depending on the aircraft, though, there may be additional 
cameras available elsewhere on and around the aircraft, looking at a variety of 
different directions and perspectives. 

 

Camera Position 

This menu item determines where the camera will be situated when view from the 
ground.  Depending upon the airport selected, there may be one or more Pilot Spawn 
locations to use as camera positions. 
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RealFlight Drone automatically picks the default Pilot Spawn for the airport that you 
have loaded. 

To change the setting, click on the viewport to you wish to modify.  This becomes the 
active view in the simulation.  To access the Camera Position adjustments, click on the 
View menu followed by the Camera Position menu item.  Select your preferred view 
from the drop-down list. 

You may also press the keyboard’s ‘X’ key to toggle through the available Camera 
Position options.  If the airport has two pilot spawn locations, for example, pressing 
the ‘X’ key will toggle back and forth between these two locations. 

 

Look At 

This menu item will force the camera to look at your aircraft, if you have moved to 
where you no longer can see it.  Usually you will want the camera to remain focused on 
your aircraft. 
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Zoom Type 

The Zoom Type menu item allows you to change the type of zoom used in the 
simulation. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Type menu item, click on the View menu followed 
by the Zoom Type menu item.  Select the Zoom Type option that accomplishes your 
goal.  You may choose between Manual, Autozoom, and Keep Ground in View. 

Autozoom- 

This zoom type adjusts the zoom range based on the distance of the aircraft 
from the pilot.  The camera automatically zooms in as the aircraft gets further 
from the pilot and then automatically zooms out as the aircraft gets closer to 
the pilot. 

Keep Ground in View- 

This zoom type attempts adjust the camera so that the aircraft and the ground 
are always in view.  This is the only zoom type that disallows zooming in and 
out. 

Manual- 

This enables the standard view with zoom capabilities.  See the Zoom In and 
Zoom Out sections below for more information. 
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Zoom In 

Once you have selected the type of zoom that you desire, RealFlight allows you to 
customize it further by zooming in. 

 

Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom In menu item, click on the View menu followed by 
the Zoom In menu item. 

 

Zoom Out 

Once you have selected the type of zoom that you want you can customize it further 
by zooming out.  Zooming Out decreases the magnification. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Out menu item, click on the View menu followed by 
the Zoom Out menu item. 

 

Zoom Reset 

This selection resets the zoom magnification level to its default value.  This is useful if 
you are zoomed way in or way out and want to return quickly to the default level of 
magnification. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Reset menu item, click on the View menu followed 
by the Zoom Reset menu item. 
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Help Menu 

When all else fails, ask for help. 

his menu provides you with miscellaneous assistance and guidance with a 
variety of simulator-related issues. 

To access the Help files, click on the Help menu title. 
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RealFlight Help 

This menu item accesses RealFlight Drone’s manual which you are reading now. 

 

To access the RealFlight Help file, click on the Help menu title. 

 

Radio Interface Help 

We understand that setting up RealFlight to function correctly with your real 
transmitter can be daunting the first time.  To assist you with this particular task, we’ve 
provided a guide to walk you through this setup. 



 

 113 

 

To access this guide, click the Radio Interface Help menu item. 

 

Keyboard Commands 

RealFlight allows you to access menu and other commands from your computer’s 
keyboard.  A key that directly invokes a command is called a “quick key” or “hot key”. 

For example, pressing the [+] (plus) key on the keyboard’s number pad incrementally 
zooms your view towards the aircraft.  This is exactly the same result that arises if you 
select Zoom In from RealFlight Drone’s View menu item.  Consequently, we say that 
the [+] (plus) is a hot key for the Zoom In command. 
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To access the Keyboard Commands, click the Help menu title, followed by the 
Keyboard Commands menu item. 

The following overlay will appear: 
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The Keyboard Commands screen contains all of the information pertaining to the hot 
keys.  To view the entire list, drag the scroll bar on the right side of the Keyboard 
Commands screen down.  Alternatively, this list is also contained on the back cover of 
the Installation Guide which accompanied this software. 

Clicking on the ‘X’ in the title tab of the frame will remove it from the screen. 

 

Welcome Screen 

The Welcome Screen that appears when you first start RealFlight can be accessed at 
any time from this menu item. 
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The Welcome Screen gives you the ability to change aircraft and flying sites.  You may 
also select a most recently flown aircraft, or open the video player window. 

 

Video Player 

At some point, you may wish to expand you flying skills beyond drones to other types 
of aircraft, like planes and helicopters. At that time, we suggest considering upgrading 
to the full version of RealFlight. Click this menu item to view a guided tour of many of 
the features available to you if you upgrade. 
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The Video Player is also accessible from the Welcome Screen. 

 

Websites 

This menu item contains direct links to the RealFlight related websites.  Please ensure 
that you are connected to the internet before making your selection.  The options 
include: 
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Great Planes- 

Publishers of RealFlight Drone.  Visit this site for information pertaining to the 
many other Great Planes products available. 

Knife Edge Software- 

Developers of RealFlight Drone.  Visit the Knife Edge forums to share 
experiences and technical support with other RealFlight owners.  The Knife 
Edge forums also play host to a wide variety of free, downloadable aircraft, 
trim schemes, flying sites and more for the full version of RealFlight. 

RealFlight- 

Visit the RealFlight website for more information about the RealFlight family 
of products, search the knowledge base for technical support, or for 
information on how to contact our support staff if you have questions. 
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License 

This menu item contains the End Users License Agreement (EULA) for the RealFlight 
Drone Flight Simulator.  Please read it carefully. 

 

Clicking on the ‘X’ in the title tab of the frame will remove it from the screen. 

 

About 

The About… menu item contains miscellaneous information pertaining to your 
software including your RealFlight serial number, InterLink Elite serial number and the 
version number of the software that you are currently operating. 
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Also seen in the About screen are the credits and names of the people that have 
worked together to bring you the world’s most realistic R/C simulator, RealFlight 
Drone. 

Clicking on the ‘X’ in the title tab of the frame will remove the About window. 
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RealFlight Drone Launcher 

The RealFlight Drone Launcher is the gateway to simulator fun! 

his item allows you to run the simulation, register and update the software, and 
much, much more. 

To run RealFlight or to access the additional options, click the RealFlight 
Drone Launcher icon located on your desktop. 

 

Appendix 

A 

T 



 

 122 

 

Run RealFlight 

To start running RealFlight, double-click the RealFlight Drone Launcher located on 
your desktop.  Next, click the Run RealFlight button.  The simulation will begin 
loading the terrain, airport objects, textures, etc.  Your simulation experience will begin 
as soon as the loading process completes. 

 

Additional Options 

Click on the Additional Options button to access a variety of useful RealFlight Drone 
information and miscellaneous functions. 
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Restore Defaults- 

Use this button to restore RealFlight Drone’s default settings.  It is designed to simply 
restore the factory default values and settings for the simulation. 

Registration/Updates- 

Use this button to register and update the software. 

   

Online Registration- 

This button allows you to register your copy of RealFlight Drone.  The 
registration information entitles you to complimentary technical support and 
free online updates. 

Please enter all of the required information to complete the registration.  If you 
forget your password, contact the Great Planes Software Support team.  To do 
so, email them at rfsupport@greatplanes.com or telephone them at 217-398-
8970 (option #1).  They will confirm your identity, and reset your password. 
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RealFlight Newsletter- 

Periodically, Great Planes will send out an electronic newsletter to 
customers that are subscribed.  The newsletter includes information 
about new products, shows we are attending, tips and tricks and other 
useful items.  If you wish to receive this newsletter check the box 
labeled Yes, I want to receive the RealFlight newsletter via email. 

Hardware Information- 

RealFlight Drone offers the option of automatically sending us 
information pertaining to your system hardware and settings when you 
register.  If you leave the Send Hardware Information box checked 
when you register, RealFlight Drone will send us this information. 

This hardware information will assist us in diagnosing any problems 
you may encounter later, should you need to contact Technical 
Support. Consequently, we suggest that you leave this box checked 
when registering. 

This feature is optional.  If you uncheck the box, RealFlight Drone will 
not send us any information about your system.  Alternatively, you can 
view exactly what information RealFlight will send us before you 
decide.  To view the information, click the Technical Support button 
on the main RealFlight Drone Launcher window.  When the Technical 
Support page appears, click Assemble System Information. 

Update to Latest Version- 

After registering (you only need to register once), you may update to the latest 
version of the software.  This will download all necessary files and correctly 
install the upgrade. 

Click this button to update to the latest version of RealFlight Drone.  

Please note:  Your PC must be connected to the internet in order to check for 
updates. 

Check for Updates Before Starting RealFlight- 

If you check this box, every time you run the RealFlight Drone software it will 
check to determine whether or not there is a more recent version of RealFlight 
Drone available to you.  If a new version exists, RealFlight Drone will ask if 
you wish to download and install the newer build. 

Please note:  Your PC must be connected to the internet in order to check for 
updates. 
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Update to Specific Version- 

If you are experiencing difficulties with a version you have installed, this will 
allow you to retrieve a previous version of the software.  If the previous 
version fixes your problem, please contact our technical support team at 
rfsupport@greatplanes.com and let them know about the difficulty 
encountered. 

Clear Download Cache- 

Occasionally, files may become corrupt during a download.  If you are having 
difficulties with the online updates, remove all cached files using this option.  
Next, choose Update to Specific Version and then select the Completely 
Refresh option. 

Uninstalling RealFlight- 

Click the Uninstall RealFlight button to uninstall the software.  The following dialog 
will appear: 

 

The RealFlight Drone Launcher will remove all necessary RealFlight Drone files. 

Uninstall Program- 

Choose this option to uninstall only the RealFlight Drone program itself. 

Remove Serial Numbers- 

Choose this option to remove the serial numbers from your system.  This will 
remove the RealFlight and InterLink serial numbers as well as your online 
activation.   

Remove All Cached Files From The Online Update- 

Choose this to option to remove all cached download files from your system.  
If you uninstall these files, future downloads may take a little longer. 
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View Web Site- 

Click the View Web Site to visit the RealFlight web site.  A browser window will open 
for you and you will be automatically directed to the site.  

Please note:  Your PC must be connected to the internet in order to view the 
RealFlight web site. 

Read Help File- 

Press the Read Help File button to bring up the manual, this document that you are 
reading now, for RealFlight Drone. 

Technical Support- 

Press the Technical Support button to bring up technical support information 
pertaining to your system.  If you encounter any difficulties with RealFlight, this 
information can help you to resolve the situation on your own, or may assist Great 
Planes’ Support Staff to diagnose the problem. 

 

System Information- 

The pave on the upper-left portion of the window displays a list of the critical 
system information.  Before you email technical support, or report a bug with 
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the software, please be sure to cut and paste this information into your email.  
This will greatly assist them in diagnosing the difficulty. 

Reinstall DirectX- 

Choose this option to reinstall Microsoft’s DirectX on your computer.  
Occasionally this will fix corrupted installations. 

Enter Technical Support Code- 

Choose this option to enter a technical support code.  If you do encounter 
problems running RealFlight, our Technical Support team may supply you 
with a code to input here.  Entering this code will help them diagnose or 
resolve your difficulty. 

 

Email Technical Support- 

This gives you the email address rfsupport@greatplanes.com to which you can 
email your difficulties.  If you do email us, please be sure to attach the 
Assemble System Information output to your email. 

You will receive an auto-reply message back confirming that Great Planes 
Support Staff received your email.  If you do not receive the auto-reply 
message, please double-check that you sent your email to the correct email 
address. 

Assemble System Information- 

Choose this option to collect critical information about your system, and about 
your RealFlight settings.  You may find this information useful if you try to 
troubleshoot problems on your own.  Moreover, if needed you can cut and 
paste this information into an email to Great Planes Support Staff.   
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View Web Technical Support- 

Choosing this option will open a browser window, and take you to a web site 
that contains the most up-to-date technical support information for RealFlight. 

View Tasks- 

This shows you a list of all tasks that are running on your computer.  Some 
tasks can interfere with RealFlight Drone and may need to be closed. 

Include Serial Numbers- 

Check this box if you plan to assemble all system information to send to Great 
Planes Support Staff.  If you are sending this information to anyone else, don’t 
check this box.  The serial numbers are unique to you, and should only be 
shared with Great Planes Support Staff. 

DX Diagnostics- 

This brings up Microsoft’s DXDIAG utility.  Using this utility can further help 
diagnose your system. 



 

 129 

Please note:  If you send us information about your system to help us diagnose 
a problem, please do not use DXDIAG to generate that information.  Instead, 
use the “Assemble System Information” option.  The “Assemble System 
Information” output file contains more information than the DXDIAG 
output. 

MSInfo- 

This option will run MSInfo.  This will give you even more information about 
your system.  This program is not always installed on a particular computer, 
but normally comes with programs such as Microsoft Office®. 

Display Properties- 

This brings up the display properties for your monitor.  You can use this page 
to change the resolution of your desktop. 

Explorer- 

This button launches Windows Explorer.  This Microsoft Windows utility can 
help you locate, move and back up your files. 

Launch Device Manager- 

This button launches the Device Manager.  This Microsoft Windows utility 
will help you determine driver dates, as well as installing and updating video 
and sound card drivers. 
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If You Experience 

Difficulties 

Tips and tricks for solving the more common problems. 

he RealFlight Drone simulator is on the cutting edge of technology, and 
therefore operates using advanced hardware.  Consequently, there is always 
the remote possibility you may experience a few slight difficulties.  Should the 
need arise, we provide extensive resources to help. 

Besides providing the best R/C simulator, we sincerely feel that we provide the best, 
most extensive product support of any simulator.  Since hardware, drivers, and 
operating systems are always changing, we work hard to keep our support team up-to-
date on the latest information available to ensure that you have the most enjoyable 
experience possible. 

This section begins with a summary of the various sources of RealFlight Drone 
information including support and problem solving assistance.  Then, we will show 
you some simple but powerful steps that can resolve or prevent most RealFlight Drone 
difficulties.  Finally, if these steps fail to solve your difficulty, we will explain the most 
effective ways to acquire additional assistance. 

 

How to Get Help and Information 

As a RealFlight Drone user, you have access to an incredible amount of information 
about this product.  Much of this information can help you resolve difficulties, or 
correctly access and use program features.  Here is where you can find it: 

 The manual.  Most common RealFlight difficulties can be resolved by following 
the instructions in later sections of this chapter; however there is also additional 
information throughout other chapters that may be of assistance. 
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 Visit our product Knowledge Base at www.gpsoftware.com.  This is a great 
resource and is an indexed, searchable collection of articles that describe solutions 
to almost every known situation with RealFlight and all of our other software 
products.  In fact, this is the same information database used by our product 
support technicians.  

 Visit the Knife Edge Software Message Boards at www.knifeedge.com/forums/.  
This is a place where owners of RealFlight and other Knife Edge products post 
questions, comments, and responses.  Sometimes our product support technicians 
and product developers from Knife Edge post replies and announcements as well.  
You may find a thread that discusses the same difficulties that you are 
experiencing.  

 Contact our Technical Support department by email at: 
rfsupport@greatplanes.com.  Alternatively, our staff is also available via telephone 
or postal mail at: 

 
RealFlight Technical Support 
3002 North Apollo Drive 
Suite #1 
Champaign, IL 61822 
Voice phone: (217) 398-8970 (Option 1) 
FAX:  (217) 398-7721 

The product support teams are specially trained, and have many resources to help 
you resolve problems with RealFlight Drone. 

 

Before You Do Anything Else 

If you are experiencing difficulties with RealFlight Drone, you should always try the 
steps below first.  These steps really do cure most problems our users experience.  
Even if you are not having a problem, these same steps often assist in the operation of 
both RealFlight and your computer. 

 Update your video and sound card drivers (see instructions below). 

 Update to the latest version of RealFlight Drone. 

 If these steps do not work, proceed to the next section. 

 

Update Your Drivers- 

Before you do anything else, you should make sure you have updated your video and 
sound drivers.  A large number of difficulties encountered by RealFlight users can be 
cured by updating drivers. 
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A driver is a software program that controls your video or sound card.  Each card 
manufacturer provides drivers for its own cards.  To work correctly, RealFlight relies 
on your video and sound card drivers. 

It is very important to use the latest available driver for your card.  Card manufacturers 
frequently release updated drivers to fix problems that occur when the driver is used 
with programs such as RealFlight Drone.  The driver that came with your new 
computer, on your Windows disc, or on the disc included with the new card you 
bought, may not be the latest version. 

If you do not know how to update drivers, you can find instructions in our Knowledge 
Base article Q01-1038, How to Update Drivers, at http://www.gpsoftware.com/kb/q01-
1038.htm.  This page will take you through the process step-by-step, and has links to 
driver download sites for most manufacturers. 

Update to the Latest Version of RealFlight Drone- 

As we regularly release program updates, the difficulty that you are seeing may already 
be fixed in an update.  Even if you just bought RealFlight, you should update to the 
latest version.  It’s free and only requires a few minutes of your time. 

 

If You Need Additional Assistance 

You have updated drivers and updated RealFlight Drone and you are still having 
problems.  What next? 

As a first step, we suggest checking our Knowledge Base at www.gpsoftware.com.  
This is an easy to use, searchable database of known problems and solutions for 
RealFlight, RealRace, and our other software products.  This is the same database that 
our Product Support technicians use when helping customers.  We constantly update 
the knowledge base to address new problems as we discover them.  In many cases, you 
will be able to find an article that gives clear, concise instructions for resolving your 
difficulty. 

You may want to check the Knife Edge Forums at www.knifeedge.com/forums/.  
This is a place where owners of RealFlight and other Knife Edge products post 
questions, comments and responses about problems.  You may find a discussion 
thread about the problem you are experiencing. 

You can also contact Technical Support at Great Planes via email at: 
rfsupport@greatplanes.com. 

IMPORTANT.  If you do contact Technical Support, you can help us enormously by 
providing detailed information about your computer system.  Since your problem may 
only occur on a particular video or sound card, particular driver version, etc., we may 
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need this information to help us diagnose your problem.  To compile your system 
information, use the RealFlight Drone Launcher.  Click the Additional Options 
button.  Next, click the Technical Support button, followed by the Assemble 
System Information button.  This will create a file called “c:\launcheroutput.txt”, 
which contains your system information.  Attach this file to an email and send it to us 
at rfsupport@greatplanes.com. 

 

Examples of Common Problems and Solutions 

If You Don’t See Your Problem in This Chapter- 

This chapter contains a few examples of common difficulties and concerns that 
RealFlight users have experienced. 

Remember that we can never provide a complete list of difficulties and solutions in a 
program manual.  That’s because RealFlight - and the computers, cards, and drivers it 
uses - are constantly evolving.  As such, we maintain a detailed Knowledge Base at 
www.gpsoftware.com.  By keeping our Knowledge Base online, we can provide you 
with the latest information about resolving any difficulties that might arise.  If you 
don’t see your difficulty described in this chapter, please check the Knowledge Base. 

In this chapter, we’ve simply tried to pick a very short list of the most asked about 
issues. 

My computer “freezes” when I run RealFlight- 

Sometimes, you may also notice sound skipping or repeating, or a computer reboot 
while flying.  To resolve this type of problem, you must update the drivers for your 
video and sound cards.  This is very important.  Card manufacturers regularly update 
their drivers to fix this type of problem.  Even the driver that came with your new 
computer may not be the most recent. 

Sometimes a card manufacturer will offer a choice between a “recommended” driver, 
and another driver (often called “special purpose”, “alternate”, or “beta” driver).  If 
RealFlight Drone “freezes” with the “recommended” driver, try using the alternate 
driver instead. 

If you are sure that you are using the latest drivers, and have followed all the other 
steps in the previous section (update RealFlight Drone, test DirectX) and are still 
having difficulty with your computer locking up while running RealFlight, please 
contact Great Planes Technical Support. 
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Improving RealFlight Drone Performance- 

During installation, RealFlight Drone analyzes your computer’s hardware 
specifications.  RealFlight Drone then tries to optimize its configuration to best take 
advantage of that hardware, and achieve the best possible performance. 

However, if the performance is less than you desire, you can adjust some of RealFlight 
Drone’s settings to improve the simulation speed and frame rate: 

 Ensure that the drivers for the video and sound cards are up-to-date. 

 Turn off all other programs, especially virus checkers and network applications 
(such as Instant Messengers) while running RealFlight Drone.  Use CTRL-ALT-
DELETE and check the Task Manager to verify that nothing else is running in 
the background. 

 Reduce the texture, water, shadows and other graphics quality in RealFlight.  This 
can have a profound effect on cards that do not have a high texture memory.  See 
the Settings section starting on page 40 for more information. 

 Eliminate the items shown in the simulation.  To do so, access the View menu title 
then, access the Scenery menu item.  Click an item, type to remove it from the 
simulation.  It may be necessary to eliminate several items before performance 
meets your expectations. 

 Reduce the number of open Gadgets and Viewports.  Click the ‘X’ on each Gadget 
or Viewport that you wish to close. 

 

Other Common Problems- 

Here are some other things you may want to watch for: 

 Check the DVD for scratches or blemishes.  Even minor scratches or fingerprints 
can cause random problems that appear to be program bugs. 

 Verify that all other programs are closed prior to starting RealFlight Drone.  
RealFlight works best when it is the only program running. 

 If all else fails, try rebooting your computer occasionally, Windows may become 
unstable after prolonged and continuous use.  A simple reboot may clear up any 
difficulty. 
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Transmitter Modes 

 

hroughout world, pilots will fly using radios in different Modes.  The Mode 
refers to the transmitter’s gimbal stick assignments which determine the flight 
mode of your controller.  There are two main modes of control.  Mode 1, 
mostly used in Europe and Mode 2 which is the predominant method of 

controlling aircraft. 

Mode 1- 

A controller which is designated as Mode 1 means that it contains the throttle and 
aileron on the right stick.  The left stick will, therefore, control the elevator and rudder. 

 
Elevator 

 
Rudder 

 
Throttle 

 
Aileron 

 

Mode 2- 

A controller which is designated as Mode 2 will have the left stick controlling the 
throttle and the rudder.  Conversely, the right stick will control the elevator and the 
ailerons. 

Appendix 

C 

T 



 

 
137 

 
Throttle 

 
Rudder 

 
Elevator 

 
Aileron 

 

Convert Mode 2 to Mode 1 

 
The RealFlight InterLink Elite is primarily offered in the Mode 2 configuration.  If you 
wish to convert your InterLink controller to Mode 1 for use with RealFlight, please 
following these directions. 

Tools Required- 

 Medium Phillips-head screwdriver 

 Hemostats (preferred), or needle nose pliers 

Instructions- 

 

Please read all instruction carefully before you begin this conversion.  Great Planes will 
not accept responsibility for incidental damage to your InterLink controller or personal 
computer as a result of failure to adhering to these instructions properly.  Please 
control Software Support prior to performing this conversion if you have any 
questions about this procedure. 

1. Make sure your InterLink Elite controller is completely disconnected from 
your computer.  Failure to do so could result in permanent damage to your 
InterLink Elite controller and/or your computer. 

2. Remove the four screws from the rear of the controller, remove the case rear 
half, and lay the controller face-down on your workspace. 

3. Remove the silver metal ratchet lever and screw from the gimbal on the right-
hand side.  Rotate the metal ratchet 180 degrees, so the screw hole is now on 
the bottom right side of the gimbal, and the ratchet end is now pointing 
upward nearest the switch on the top right side, and resting on the ribbed 
surface of the gimbal.  Line up the lever’s hole over the plastic mounting stud 
on the gimbal, insert the screw and tighten to a snug fit (making sure the lever 
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maintains proper alignment over the ribbed area of the gimbal).  DO NOT 
OVERTIGHTEN, as the plastic gimbal may become easily stripped. 

4. On the right-hand gimbal, notice there is an arm and spring type lever 
mounted vertically along the inner-left side of the gimbal, the spring attached at 
the lower end to a plastic mounting stud.  This arm and spring assembly must 
now be moved to the left-hand gimbal.  Using pliers, gently pry the head of the 
spring upwards off of the plastic arm.  Now remove the spring and arm from 
the gimbal (this may require slight maneuvering of the parts to get them out 
from behind the main body of the gimbal).  NOTE:  Pivot the arm outward, 
then slide to the side to remove it from the gimbal. 

5. Looking at the left-hand gimbal from the back, on the inner-right side, notice a 
similar arm and spring mounting lugs as were on the other gimbal, except the 
spring lug is now on the top end and the pivot arm lug is on the bottom end.  
Take the arm just removed from the other gimbal, insert the pivot end onto 
the round pivot lug on the lower inside part of this gimbal and rotate the arm 
upward over the gimbal.  Insert the spring down into the gimbal so the loop 
on the opposite end hooks onto the plastic lug located on the inside top-end of 
the gimbal.  Once hooked, gently pull the opposite end of the spring outward 
and loop it over the end of the plastic arm.  If any questions arise to the 
assembly of the arm and spring, refer to the arm already in place on the 
bottom of the gimbal, as they are assembled in the same manner. 

6. Both gimbals are now in the Mode 1 configuration.  No alteration of any wires 
is necessary.  Reinstall the rear of the case onto the front half, care that no 
wires are pinched between the two case halves.  Reinstall the four case screws. 

Configure RealFlight- 

Once you have made the changes to your InterLink controller, you will now need 
to make some minor changes in RealFlight to match your controller’s 
configuration. 

First, adjust the channel mapping by editing the InterLink Profile.  See Select 
Controller section on page 34 for more information about his process. 

Last, make sure the on-screen Radio Gadget is also switched to Mode 1, found 
under the Gadgets menu.  See Radio Mode on page 99 for more details. 
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U.S. Patent, 29 

Uninstalling, 125 

Updates, 123, 133 

USB, 1 

Video Card, 6 

Video Player, 116 

View Menu, 101 

Viewport, 3, 24, 95 

VirtualRevolution, 3 

Warnings, 53 

Water, 58 

Websites, 117 

Welcome Screen, 115 

Wind, 65, 81 

Wind Gust, 66 

Wind Variation, 65 

Wind Direction, 82 

Wind Speed, 82 

Zoom In, 108 

Zoom Out, 108 

Zoom Reset, 109 

Zoom Type, 106 



 

 
141 

License 

REGISTERED VERSION: RealFlight® R/C Simulator 

LIMITED USE SOFTWARE LICENSE AGREEMENT 

        This Limited Use Software License Agreement (the "Agreement") is a legal 
agreement between you, the end-user, and Knife Edge Software ("KES").  By 
continuing the installation of this game program, by loading or running the game, or by 
placing or copying the game program onto your computer hard drive, you are agreeing 
to be bound by the terms of this Agreement.  If you do not agree to the terms of this 
Agreement, promptly return the game program and the accompanying items (including 
all written materials), along with your receipt to the place from where you obtained 
them for a full refund.  

KES SOFTWARE LICENSE 

        1.      Grant of License.  KES grants to you the limited right to use one (1) copy of 
the enclosed or foregoing game program (the "Software") on a single computer.  You 
have no ownership or proprietary rights in or to the Software or the written materials 
accompanying the Software.  For purposes of this section, "use" means loading the 
Software into RAM, as well as installation on a hard disk or other storage device.  The 
Software shall be either returned to KES or destroyed when no longer used in 
accordance with this Agreement, or when the right to use the Software is terminated.  
You agree that the Software will not be shipped, transferred or exported into any 
country in violation of the U.S. Export Administration Act (or any other law governing 
such matters) and that you will not utilize, in any other manner, the Software in 
violation of any applicable law.  

        2.      Commercial Use is Prohibited.  Except as provided in paragraph 5. Herein 
below in regard to the Software, under no circumstances shall you, the end-user, be 
permitted, allowed or authorized to commercially exploit the Software, any data 
comprising the Software.  Neither you nor anyone at your direction shall do any of the 
following acts (any such acts shall be deemed void and a breach of this Agreement) 
with regard to the Software, or any portion thereof, such as a screen display or a 
screenshot:  

a. Rent the Software; 

b. Sell the Software; 

c. Lease or lend the Software; 
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d. Offer the Software on a pay-per-play basis; 

e. Distribute, by electronic means or otherwise, the Software for money or any other 
consideration; or 

f. In any other manner and through any medium whatsoever commercially exploit the 
Software or use the Software for any commercial purpose.  

        3.      Additional Prohibited Uses.  Neither you nor anyone at your direction shall 
take the following action in regard to the Software, or any portion thereof, such as a 
screen display or a screenshot:  

a. Modify, disassemble, reverse engineer or decompile Software;  

b. Translate the Software; 

c. Reproduce the Software; 

d. Publicly display the Software;  

e. Prepare derivative works based upon the Software except Permitted Derivative 
Works); or 

f. Distribute, by electronic means or otherwise, the Software.  

        4.     Use of Other Material is Prohibited.  Use, in any manner, of the trademarks, 
such as RealFlight R/C Simulator (tm) logo, or symbols, art work, images, screen 
displays or screenshots, sound effects, music, and other such material contained within, 
generated by or relating to the Software is prohibited. 

        5.      To Receive Permission to Commercially Exploit.  If you desire to 
commercially exploit the Software, you may request a copy of and execute the 
Commercial Exploitation License Agreement for RealFlight R/C Simulator (the 
"License") and forward the original License to KES Software at the address noted 
therein.  Please note that KES may refuse your request and not sign the License in 
KES's sole discretion.  

        6.      Restrictions Apply to Third Parties.  The prohibitions and restrictions 
described herein apply to anyone in possession of the Software and/or Permitted 
Derivative Works.  

        7.      Copyright.  The Software and all copyrights related thereto (including all 
characters and other images generated by the Software or depicted in the Software) is 
owned by KES and is protected by United States copyright laws and international 
treaty provisions. You must treat the Software like any other copyrighted material. You 
may not otherwise reproduce, copy or disclose to others, in whole or in any part, the 
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Software.  You may not copy the written materials accompanying the Software.  The 
same restrictions and prohibitions regarding your use of the Software as provided in 
this Agreement apply to your use of the written materials accompanying the Software.  
The written materials are owned by KES and are protected by United States copyright 
laws and international treaties.  You agree to use your best efforts to see that any user 
of the Software licensed hereunder complies with this Agreement. 

        8.      Limited Warranty.  KES warrants that if properly installed and operated on a 
computer for which it is designed, the Software will perform substantially in 
accordance with the accompanying written materials for a period of ninety (90) days 
from the date of purchase of the Software.  KES's entire liability and your exclusive 
remedy shall be, at KES's option, either (a) return of the price paid or (b) repair or 
replacement of the Software that does not meet KES's Limited Warranty.  To make a 
warranty claim, return the Software to Hobby Services at 3002 North Apollo Drive, 
Suite #1, Champaign, IL 61822 accompanied by proof of purchase, your name, your 
address, and a statement of defect.  This Limited Warranty is void if failure of the 
Software has resulted in whole or in part from accident, abuse, misapplication or 
violation of this Agreement.  Any replacement Software will be warranted for the 
remainder of the original warranty period or thirty (30) days from your receipt of the 
replacement software, whichever is longer.  This warranty allocates risks of product 
failure between Licensee and KES.  KES's product pricing reflects this allocation of 
risk and the limitations of liability contained in this warranty.  

        9.      NO OTHER WARRANTIES.  KES DISCLAIMS ALL OTHER 
WARRANTIES, BOTH EXPRESS IMPLIED, INCLUDING BUT NOT 
LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE WITH RESPECT TO THE 
SOFTWARE AND THE ACCOMPANYING WRITTEN MATERIALS.  THIS 
LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU MAY 
HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO 
JURISDICTION.  KES DOES NOT WARRANT THAT THE OPERATION OF 
THE SOFTWARE WILL BE UNINTERRUPTED, ERROR FREE OR MEET 
LICENSEE'S SPECIFIC REQUIREMENTS.  THE WARRANTY SET FORTH 
ABOVE IS IN LIEU OF ALL OTHER EXPRESS WARRANTIES WHETHER 
ORAL OR WRITTEN.  THE AGENTS, EMPLOYEES, DISTRIBUTORS, AND 
DEALERS OF KES ARE NOT AUTHORIZED TO MAKE MODIFICATIONS 
TO THIS WARRANTY, OR ADDITIONAL WARRANTIES ON BEHALF OF 
KES.  ADDITIONAL STATEMENTS SUCH AS DEALER ADVERTISING OR 
PRESENTATIONS, WHETHER ORAL OR WRITTEN, DO NOT 
CONSTITUTE WARRANTIES BY KES AND SHOULD NOT BE RELIED 
UPON. 

        10.     Exclusive Remedies.  You agree that your exclusive remedy against KES, its 
affiliates, contractors, suppliers, and agents for loss or damage caused by any defect or 
failure in the Software regardless of the form of action, whether in contract, tort, 
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including negligence, strict liability or otherwise, shall be the return of the purchase 
price paid or replacement of the Software.  This Agreement shall be construed in 
accordance with and governed by the laws of the State of Oregon. Copyright and other 
proprietary matters will be governed by United States laws and international treaties.  
IN ANY CASE, KES SHALL NOT BE LIABLE FOR LOSS OF DATA, LOSS OF 
PROFITS, LOST SAVINGS, SPECIAL, INCIDENTAL, CONSEQUENTIAL, 
INDIRECT OR OTHER SIMILAR DAMAGES ARISING FROM BREACH OF 
WARRANTY, BREACH OF CONTRACT, NEGLIGENCE, OR OTHER 
LEGAL THEORY EVEN IF KES OR ITS AGENT HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY 
OTHER PARTY. Some jurisdictions do not allow the exclusion or limitation of 
incidental or consequential damages, so the above limitation or exclusion may not 
apply to you.  

        11.     General Provisions.  Neither this Agreement nor any part or portion hereof 
shall be assigned, sublicensed or otherwise transferred by you.  Should any provision of 
this Agreement be held to be void, invalid, unenforceable or illegal by a court, the 
validity and enforceability of the other provisions shall not be affected thereby.  If any 
provision is determined to be unenforceable, you agree to a modification of such 
provision to provide for enforcement of the provision's intent, to the extent permitted 
by applicable law.  Failure of a party to enforce any provision of this Agreement shall 
not constitute or be construed as a waiver of such provision or of the right to enforce 
such provision.  If you fail to comply with any terms of this Agreement, YOUR 
LICENSE IS AUTOMATICALLY TERMINATED.  

        YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, 
THAT YOU UNDERSTAND THIS AGREEMENT, AND UNDERSTAND 
THAT BY CONTINUING THE INSTALLATION OF THE SOFTWARE, BY 
LOADING OR RUNNING THE SOFTWARE, OR BY PLACING OR 
COPYING THE SOFTWARE ONTO YOUR COMPUTER HARD DRIVE, 
YOU AGREE TO BE BOUND BY THIS AGREEMENT'S TERMS AND 
CONDITIONS.  YOU FURTHER AGREE THAT, EXCEPT FOR WRITTEN 
SEPARATE AGREEMENTS BETWEEN KES AND YOU, THIS 
AGREEMENT IS A COMPLETE AND EXCLUSIVE STATEMENT OF THE 
RIGHTS AND LIABILITIES OF THE PARTIES. THIS AGREEMENT 
SUPERSEDES ALL PRIOR ORAL AGREEMENTS, PROPOSALS OR 
UNDERSTANDINGS, AND ANY OTHER COMMUNICATIONS BETWEEN 
KES AND YOU RELATING TO THE SUBJECT MATTER OF THIS 
AGREEMENT. 
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Legal Program © 2015, Knife Edge Software, LLC 
Title Page, Box, DVD Art © 2015, Hobbico, Inc. 

FMOD sound and music system, 
© Firelight Technologies, Pty Ltd. 1994-2015 

Airfoil data courtesy  
UIUC Airfoil Coordinates Database 
Prof. Michael Selig, Department of Aero Engineering, 
University of Illinois at Urbana-Champaign, 
http://www.ae.uiuc.edu/ 
included under the terms of the GNU GENERAL PUBLIC 
LICENSE 
An ASCII readable version of this data can be found on 
your RealFlight Drone installation DVD. 

Portions of this software utilize SpeedTree technology.   
©2015 Interactive Data Visualization, Inc.  All rights reserved. 

Electric power system database courtesy of 
Capable Computing Inc., creators of MotoCalc. 

This software is based in part on the work of 
the Independent JPEG Group 

All trademarks and registered trademarks are the property  
of their respective owners. 

 


